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Avant-propos 
 
Ce manuel a été créé par Hologic®, Inc. Il est destiné à guider l’utilisateur avancé sur la façon de configurer, d’installer et 
d’utiliser le matériel Faxitron Core et le système logiciel Vision, tous deux développés par Hologic, Inc. 
 
L’utilisateur doit d’abord configurer le matériel, puis lancer le logiciel Vision. Veuillez consulter les procédures de configuration 
requises dans la Section 4 de ce manuel avant de continuer. 
 
 
 
 
 
Indications d’utilisation 
 
Le système de radiographie d’échantillons numérique (DSR) Faxitron Core est un système d’imagerie radiologique 
numérique en armoire destiné à générer et à contrôler les rayons X pour l’examen de diverses régions anatomiques, et à fournir 
une vérification rapide que le bon tissu a été excisé pendant la biopsie percutanée. La possibilité de procéder à cette vérification 
directement dans la même salle de biopsie accélère le déroulement des opérations et réduit ainsi la durée nécessaire à l’examen 
du patient. La radiographie d’échantillons peut potentiellement limiter le nombre de rappels de patients. Ce dispositif est destiné 
à être utilisé partout où les professionnels de santé le jugent approprié, y compris dans un bloc opératoire ou une salle adjacente 
à un bloc opératoire.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

www.hologic.com/package-inserts 
 

http://www.hologic.com/package-inserts


 
 

MANUEL DE L’UTILISATEUR DU FAXITRON CORE | HOLOGIC | RÉVISION 045 

Faxitron® Core 
Système de radiographie d’échantillons 

  1 

SECTION 1 
Introduction et  

symboles  
 

 
 

  



 
 

 
MANUEL DE L’UTILISATEUR DU FAXITRON CORE | HOLOGIC | RÉVISION 045 

SECTION 
Introduction et 
symboles 1 

1 - 2 

Faxitron® Core 
Système de radiographie d’échantillons 

Ce manuel a été créé par Hologic, Inc. Il est destiné à guider l’utilisateur sur la façon de configurer, 
d’installer et d’utiliser le matériel Faxitron Core et le logiciel Vision, tous deux développés par 
Hologic, Inc. 
 
L’utilisateur doit d’abord configurer le matériel, puis lancer le logiciel Vision. Au minimum, veuillez 
revoir les procédures de configuration et de sécurité requises dans ce manuel avant d’essayer de 
faire fonctionner le système. 
 
Merci de la part de nous tous à Hologic, Inc. 
 
Fabricant et coordonnées 
 

 
 
 

Hologic, Inc. 
36 Apple Ridge Road 
Danbury, CT 06810, États-Unis 
1.800.447.1856 
www.hologic.com 
 

 
SPONSOR AU 
Hologic (Australie et Nouvelle-Zélande) Pty Ltd 
Suite 302, Level 3 
2 Lyon Park Road 
Macquarie Park NSW 2113 
Tél. : 02 9888 8000 

 
 

Hologic, BV 
Da Vincilaan 5 
1930 Zaventem 
Belgique  
Tél. : +32 2 711 46 80 
Fax : +32 2 725 20 87 
 

 

 

 1.0.0 
Introduction 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Les symboles suivants sont utilisés dans ce manuel et dans le système d’aide en ligne : 
 
 
Avertit le lecteur d’un risque d’électrocution s’il ignore l’avertissement et utilise 
délibérément des outils spécialisés pour ouvrir une armoire électrique scellée et 
manipuler son contenu. Remarque : aucun outil n’est fourni par Hologic, Inc. 
 
 
Avertit le lecteur d’une situation dangereuse. Ce symbole est généralement 
accompagné d’un symbole plus spécifique et d’instructions appropriées 
concernant la nature du danger, l’issue prévisible du danger et les informations 
permettant d’éviter le danger. 
 
 
Incite le lecteur à faire preuve de prudence lorsqu’il soulève du matériel lourd afin 
d’éviter les blessures corporelles et les dommages matériels. 
 
 
Avertit le lecteur qu’un rayonnement ionisé est émis dans la zone marquée lorsque 
le faisceau de rayons X est activé. Le Faxitron Core est doté de dispositifs de 
verrouillage de sécurité pour empêcher l’accès à la zone marquée pendant que le 
faisceau de rayons X est activé. 
 
 
Avertit le lecteur qu’il doit utiliser une protection appropriée (comme des gants 
chirurgicaux ou un récipient pour échantillon approuvé) pour éviter l’exposition à 
des matières potentiellement infectieuses comme les échantillons de tissus des 
patients. 

  
1.1.0 
Symboles 
d’avertissement et 
de mise en garde 
de ce manuel 

http://www.hologic.com/
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Symbole Description 

 

Débarrassez-vous du matériel électronique 
et électrique séparément des déchets normaux. 
Renvoyez le matériel hors service à Hologic 
ou contactez votre représentant du service 
à la clientèle. 

 

Fabricant 

 

Date de fabrication 

  

Mise en garde — Rayonnement 
(production de rayons X) 

 

Mise en garde — Matières potentiellement 
infectieuses 

 

Avertissement Électricité 

 

Mise en garde 

   Suivez ou consultez le mode d’emploi 

 

Ce système transmet de l’énergie RF 
(radiofréquence) et des rayonnements 
non ionisants 

 
Représentant autorisé pour l’Europe 

 
Dispositif médical 

 
Numéro de catalogue 

 
Numéro de série 

 

 1.1.1 
Symboles 
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de mise en garde 
sur l’étiquette 

 

ou 

ou 



 

MANUEL DE L’UTILISATEUR DU FAXITRON CORE | HOLOGIC | RÉVISION 045 

Faxitron® Core 
Système de radiographie d’échantillons 

2 

SECTION 2 
Sécurité concernant  

le rayonnement 
et rayons X 

 
 
 
 
 
 
 
 
 
 

  



 
 

MANUEL DE L’UTILISATEUR DU FAXITRON CORE | HOLOGIC | RÉVISION 045 

SECTION 
Sécurité 
concernant le 
rayonnement 

 
  

2 

2 - 2 

Faxitron® Core 
Système de radiographie d’échantillons 

Le rayonnement est une énergie sous forme d’ondes ou de particules. Le rayonnement à haute 
fréquence et à haute énergie, dont l’énergie suffit à éjecter un électron de son orbite autour d’un 
noyau, est appelé rayonnement ionisant. Les rayons X, les rayons gamma, les particules bêta, 
les particules alpha et les neutrons constituent tous des formes de rayonnement ionisant et 
peuvent être émis par des matières radioactives, des étoiles et des équipements à haute tension. 

Nous ne pouvons pas voir, sentir, goûter, sentir ou entendre les rayonnements ionisants, c’est 
pourquoi il est nécessaire de posséder un équipement de surveillance pour les détecter. 

Rayons X 
Les rayons X sont des rayonnements à haute fréquence et à haute énergie, dont l’énergie suffit 
à éjecter un électron de son orbite autour d’un noyau, et sont appelés rayonnements 
« ionisants ». Les rayons X sont capables de parcourir de longues distances dans l’air et dans 
la plupart des autres matériaux. La quantité d’énergie transportée par le rayonnement est 
directement proportionnelle à la fréquence, et inversement proportionnelle à la longueur d’onde. 
Les rayons X disposent d’une longueur d’onde relativement courte et d’une fréquence élevée, 
donc d’une grande quantité d’énergie. 

Les rayons X peuvent produire des changements biologiques dans les tissus qui peuvent être 
bénéfiques lorsqu’ils sont utilisés en radiothérapie. Cependant, les rayons X peuvent également 
être nocifs pour les organismes biologiques en raison de leur capacité à endommager les 
chromosomes. 

Les sources de rayonnement X dans les établissements médicaux sont notamment les 
suivantes : 

Appareils à rayons X. Les appareils à rayons X sont utilisés à des fins de traitement 
(radiothérapie) et de diagnostic. Les appareils de radiographie diagnostique sont utilisés pour 
radiographier diverses parties du corps, le thorax, les jambes, les seins, etc. à des fins de 
diagnostic. Aujourd’hui, rien qu’aux États‐Unis, la radiologie diagnostique représente les deux 
tiers de notre dose de rayons X provenant de sources artificielles. Les appareils à rayons X 
peuvent générer des niveaux élevés de rayonnement ionisant. 

Appareils à rayons X en armoire. Les appareils à rayons X en armoire sont des chambres 
d’irradiation fermées, blindées et verrouillées. L’appareil ne peut fonctionner que lorsque la 
porte de la chambre est bien fermée. Les taux d’exposition à chaque endroit à l’extérieur 
correspondent au taux spécifié pour les zones non contrôlées. 

Sources de rayonnement 
Nous sommes tous exposés quotidiennement à des rayonnements. Selon le NCRP, le Conseil 
national de radioprotection, la dose de fond moyenne aux États-Unis est de 360 mrem/an 
(3,6 mSv/an). Ces expositions proviennent principalement de sources naturelles de 
rayonnement, telles que le radon, le rayonnement cosmique et les dépôts naturels dans la terre. 
Même notre organisme contient de la radioactivité naturelle ! 

Il existe 2 sources de rayonnement : naturelles et artificielles. 

Les sources naturelles de rayonnement comprennent les rayons cosmiques, les rayons gamma 
terrestres, les radionucléides présents dans l’organisme, ainsi que le radon et ses produits de 
désintégration. La dose efficace annuelle moyenne mondiale provenant de sources naturelles 
est estimée à 2,4 mSv (240 mrem). Il existe des facteurs qui influent sur les doses efficaces de 
ces sources naturelles de rayonnement : le débit de dose des rayons cosmiques dépend de la 
altitude au-dessus du niveau de la mer et de la latitude, le débit de dose des rayons gamma 
terrestres dépend de la géologie locale, et la dose des produits de désintégration du radon 
dépend de la géologie locale et de la construction et de l’utilisation des logements. Voir le 
Tableau 1 pour les doses efficaces annuelles provenant de ces sources naturelles. 
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Tableau 1 
Dose efficace annuelle provenant de sources naturelles pour les adultes 

Source d’exposition Dose efficace annuelle (mSv) 
Typique Élevée* 

Rayons cosmiques 
Rayons gamma terrestres 
Radionucléides dans l’organisme (à l’exception du 
radon) 
Le radon et ses produits de désintégration 

0,39 
0,46 
0,23 

 
1,3 

2,0 
4,3 
0,6 

 
10 

TOTAL (arrondi) 2,4 - 
*  Les valeurs élevées sont représentatives de grandes régions. Des valeurs encore plus 

élevées sont observées au niveau local. 

Les rayons X médicaux constituent une source majeure de rayonnement artificiel. Les rayons 
X médicaux utilisent les rayonnements ionisants aussi bien pour le diagnostic que pour le 
traitement des blessures et des maladies. L’UNSCEAR (Comité scientifique des Nations unies 
pour l’étude des effets des rayonnements ionisants) estime que l’exposition individuelle aux 
rayonnements médicaux varie de 0,4 à 1 mSv par an. L’exposition aux rayonnements médicaux 
est supérieure à celle de toutes les autres sources artificielles, mais représente moins de la 
moitié de l’exposition au rayonnement naturel.  

Les doses de rayonnement ionisant utilisées dans les radiographies de diagnostic sont 
généralement assez faibles, ≤ 50 keV. 

 
Le graphique ci-dessous présente les contributions des différentes sources de rayonnement. 

 2.2.0 Suite 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 2.2.1  
Sources des doses de 
rayonnement aux États-Unis. 
 
Extrait du NCRP 160, fig. 1.1. 
Pourcentage de contribution des 
diverses sources d’exposition à la 
dose efficace collective totale 
(1 870 000 personnes-Sv) et à la 
dose efficace totale par individu 
dans la population américaine. 
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L’exposition aux rayonnements ionisants peut avoir des effets néfastes sur la santé en 
provoquant la modification des atomes et des molécules. Lorsque le rayonnement ionisant 
traverse les tissus, de grandes quantités d’énergie sont transférées aux molécules individuelles. 
Ce transfert d’énergie provoque l’éjection des électrons des atomes, ce qui déclenche divers 
effets chimiques et physiques. L’endommagement des molécules d’ADN constitue le plus 
critique de ces effets. L’organisme dispose de mécanismes qui réparent normalement ces 
dommages, mais il est possible que des dommages importants ou certains types de dommages 
ne soient pas réparés. Lorsque l’organisme est incapable de réparer les dommages, la cellule 
peut mourir ou subir une mutation. Les cellules mutées ont le potentiel de se transformer en 
cancers. L’étendue des dommages est proportionnelle à l’énergie transmise, ou à la dose de 
rayonnement ionisant reçue.  

Les effets sur la santé de l’exposition aux rayons X sont de deux types généraux, directs ou 
indirects. On pense que les rayons X créent des radicaux dans les cellules exposées de votre 
organisme, lesquels peuvent rompre ou modifier les liaisons chimiques au sein de molécules 
biologiques critiques. 

Ainsi  

(1) les cellules peuvent être altérées ou endommagées, même si de nombreuses cellules se 
réparent d’elles-mêmes, ce qui n’entraîne aucun dommage résiduel,  

(2) les cellules peuvent mourir, ce que des millions de cellules de l’organisme font chaque jour, 
et sont remplacées dans un processus biologique normal,  

(3) les cellules peuvent se réparer de manière incorrecte, ce qui peut entraîner un changement 
biophysique. Enfin, les rayons X peuvent traverser le corps sans aucune interaction. 

Les dommages causés aux cellules par les rayonnements ionisants peuvent entraîner les 
situations suivantes : 

• Production de radicaux libres. 
• Rupture des liaisons chimiques. 
• Production de nouvelles liaisons chimiques et réticulation entre macromolécules. 
• Dommages aux molécules qui régulent les processus cellulaires vitaux (par exemple, 

l’ADN, l’ARN, les protéines). 

Le débit de dose, la dose totale reçue, l’énergie du rayonnement, la surface du corps exposée, 
la sensibilité de l’individu et la sensibilité des cellules sont autant de facteurs qui déterminent 
les effets biologiques de l’exposition aux rayonnements. 

Il existe deux types d’effets de l’exposition aux rayonnements ionisants : les effets déterministes 
et les effets stochastiques. 

EFFETS DÉTERMINISTES ET STOCHASTIQUES 

Les effets biologiques potentiels dépendent de la quantité et de la rapidité auxquelles une dose 
de rayonnement est reçue. Les doses de rayonnement peuvent être regroupées en deux 
catégories, la dose aiguë et la dose chronique. 

Dose aiguë et effets déterministes 

L’exposition aiguë aux rayonnements constitue une forte dose de rayonnement se produisant sur 
une courte période, s’étendant généralement de quelques secondes à quelques jours. Les effets 
provoqués par les doses aiguës de rayonnement sont dits déterministes ; la gravité de l’effet est 
déterminée par la quantité de dose reçue. Les effets déterministes ont généralement un certain 
niveau de seuil — en dessous duquel l’effet ne se produira probablement pas, mais au-dessus 
duquel l’effet sera attendu. Au-delà de ce seuil, la gravité de l’effet augmente avec la dose. 

Par exemple, une dose au corps entier d’environ 300 rems (3 Sv), soit 60 fois la limite de dose 
professionnelle annuelle, si elle est reçue dans un court laps de temps (par exemple, quelques 
heures), provoquera des vomissements et de la diarrhée en quelques heures ; une perte de 
cheveux, de la fièvre et une perte de poids en quelques semaines ; et environ 50 % de chances 
de décès, sans traitement médical. Ces effets ne se produiraient pas si la dose de 300 rems 
(3 Sv) était accumulée progressivement sur plusieurs années. 

 2.3.0 
Effets biologiques 
du rayonnement  
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déterministes et 
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Il existe également une différence entre les expositions du corps entier et les expositions 
partielles du corps. Là où une dose aiguë de 600 rems (6 Sv) sur la main provoquerait des 
rougeurs de la peau, la guérison se produirait au cours des mois suivants et aucun dommage 
à long terme ne serait attendu. Cependant, sans traitement médical, une dose aiguë de cette 
ampleur dans le corps entier pourrait provoquer le décès en peu de temps. 

L’utilisation de mécanismes de radioprotection appropriés et de limites de dose d’exposition 
professionnelle réduit la probabilité de survenue de ces effets. 

Les limites de dose professionnelle sont bien inférieures aux seuils des effets déterministes. 

Dose chronique et effets stochastiques 

Une dose chronique constitue une quantité relativement faible de rayonnement reçue sur une 
longue période (par exemple, des années). L’organisme est mieux préparé pour tolérer une 
dose chronique qu’une dose aiguë. Il a le temps de réparer les dommages causés car un plus 
petit pourcentage de cellules ont besoin d’être réparées à un moment donné. L’organisme a 
également le temps de remplacer les cellules mortes ou qui ne fonctionnent pas par de 
nouvelles cellules saines. Toutefois, cela ne signifie pas qu’il n’existe aucun risque lié à une 
exposition chronique aux rayonnements. 

Le terme stochastique signifie « aléatoire », ce qui implique que de faibles niveaux d’exposition 
aux rayonnements ne sont pas forcément susceptibles de produire un effet. Ces faibles 
niveaux, inférieurs au seuil des effets déterministes, peuvent ou non entraîner des effets 
néfastes pour l’organisme. 

Cependant il faut garder les éléments suivants à l’esprit :  

1)  Il n’existe pas de seuil d’exposition aux rayonnements en dessous duquel on peut estimer  
 avec certitude que les effets ne se produiront pas. 

2)  En doublant la dose de rayonnement, on double la probabilité de survenue des effets.  

L’exposition chronique peut produire des effets ne pouvant être observés que quelque temps 
après l’exposition initiale. Il peut s’agir d’effets génétiques ou d’autres effets tels que le cancer, 
les lésions précancéreuses, les tumeurs bénignes, les cataractes, les modifications de la peau 
et les malformations congénitales. En général, le plus grand motif de préoccupation est 
constitué par le développement d’une forme quelconque de cancer. 

Les effets immédiats ne sont pas observés à des doses inférieures à 25 rems (0,25 sievert). 
Des effets latents peuvent apparaître des années après l’administration d’une dose. Des études 
menées sur des populations exposées à des rayonnements ionisants (> 0,5 Sv) ont montré que 
la probabilité de survenue d’un cancer mortel à la suite d’une exposition aux rayonnements est 
d’environ 5 % par Sv. 

 

 

RADIOSENSIBILITÉ 

La radiosensibilité est la probabilité qu’une cellule, un tissu ou un organe subisse un effet par 
dose unitaire de rayonnement. La radiosensibilité est la plus élevée dans les cellules qui se 
divisent rapidement (très mitotiques) ou qui sont relativement peu spécialisées (indifférenciées). 
C’est pourquoi l’épiderme basal, la moelle osseuse, le thymus, les gonades et les cellules du 
cristallin sont très radiosensibles. Les muscles, les os et les tissus du système nerveux 
présentent une radiosensibilité relativement faible. De plus, la radiosensibilité est plus 
importante au stade fœtal et diminue progressivement au cours de l’adolescence et de l’âge 
adulte. 

Loi fondamentale de la radiobiologie : les effets biologiques sont directement proportionnels à 
l’indice mitotique et au devenir mitotique de la cellule exposée, et inversement proportionnels 
au degré de différenciation. La mitose fait référence à la division naturelle du noyau d’une cellule 
au cours de la reproduction cellulaire ; la différenciation fait référence au degré de spécialisation 
de la cellule pour remplir une fonction spécifique dans un organisme. 

 2.3.1 Suite 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2.3.2 
Radiosensibilité 
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RISQUES LIÉS À L’EXPOSITION AUX RAYONNEMENTS  

On estime qu’environ 20 % (1 sur 5) de tous les décès aux États-Unis sont dus à un type de 
cancer quelconque. 

Si chaque membre d’une population d’un million d’habitants recevait 10 mrem (0,1 mSv) de 
rayonnement, 5 décès supplémentaires pourraient potentiellement être observés. N’oubliez 
pas que sur cette population d’un million d’habitants, environ 200 000 mourront du cancer, ce 
qui rend ces quelques décès supplémentaires statistiquement impossibles à détecter. 

En outre, le risque de décès dû au cancer est de 0,08 % par rem (10 mSv) pour les doses 
reçues rapidement (aiguës) et pourrait être 2 fois (0,04 %, soit 4 sur 10 000) inférieur à celui 
correspondant aux doses reçues sur une longue période (chroniques). 

À partir des données actuellement disponibles, le NRC a adopté la valeur de risque pour une 
dose professionnelle de 1 rem (0,01 Sv) comme représentant un risque de 4 sur 10 000 de 
développer un cancer mortel. 

La Commission internationale de protection radiologique (publication 103, 2007) indique une 
valeur de 5,5 % par sievert pour le cancer et de 0,2 % par sievert pour les effets héréditaires 
après exposition à un rayonnement à faible débit de dose. 

Le risque associé aux utilisations diagnostiques des rayonnements ionisants est normalement 
limité aux effets stochastiques tardifs, qui surviennent à une fréquence estimée à environ 
0,01 % pour un examen moyen (des lésions cutanées déterministes peuvent se produire après 
une radioscopie, dans des cas extrêmes). Au niveau individuel, ces risques sont presque 
toujours faibles par rapport aux bénéfices du diagnostic et du traitement.  

CONCLUSIONS SUR LES RISQUES POUR LA SANTÉ 

Nous partons du principe que toute exposition aux rayonnements, aussi minime soit-elle, 
comporte un certain risque. Cependant, nous savons qu’en moyenne, ces risques sont 
comparables ou inférieurs aux risques que nous rencontrons dans d’autres activités ou 
professions considérées comme sûres. Étant donné que nous disposons d’un contrôle 
approfondi sur la quantité d’exposition aux rayonnements que nous recevons au travail, nous 
contrôlons et minimisons ce risque. La meilleure approche consiste à maintenir notre dose au 
niveau le plus bas qu’il soit raisonnablement possible d’atteindre, ou ALARA — un terme que 
nous aborderons en détail plus tard. La réduction de la dose minimise le risque. 

LIMITES DE DOSE DE L’ICRP 

La Commission internationale de protection radiologique (ICRP) a établi des limites de dose de 
rayonnement sur la base des données disponibles. Ces limites de dose sont des valeurs 
maximales autorisées pour les expositions du corps entier. L’unité de mesure de la dose est 
appelée le sievert (Sv), qui tient compte de divers facteurs pour déterminer une quantité 
appelée dose efficace. Les limites de dose ont été actualisées pour la dernière fois en 2007. 

Pour le grand public, la limite de dose est de 1 mSv/an (0,001 sievert par an). 

Pour les travailleurs exposés aux rayonnements (ceux qui travaillent dans l’industrie nucléaire), 
la limite de dose est de 20 mSv/an (0,02 sievert par an). 

Les limites de dose excluent les effets du rayonnement de fond. 

Limites de dose annuelle recommandées par l’ICRP pour les organes ou tissus individuels 
Dose de rayonnement pondérée chez Travailleurs Public 

Cristallin  150 mSv 15 mSv 
Peau 1,2  500 mSv 50 mSv 
Mains et pieds  500 mSv - 

1. La limitation de la dose efficace assure une protection suffisante de la peau contre les 
effets stochastiques. Une limite supplémentaire est nécessaire pour les expositions 
localisées afin de prévenir toute réaction tissulaire. 

2. Moyenne sur une surface de peau de 1 cm2, quelle que soit la zone exposée. 

 2.3.3  
Risques liés à 
l’exposition aux 
rayonnements 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2.3.4  
Conclusions sur 
les risques pour la 
santé 
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Facteurs déterminants 

Les effets de l’exposition aux rayons X dépendent de la durée de l’exposition, de la vitesse à 
laquelle la dose est administrée, de l’énergie — quantité d’énergie contenue dans les rayons X, 
de la dose totale — l’ampleur de la dose, et du fait que l’exposition soit totale ou localisée. Les 
rayons X de faible énergie (< 50 KeV) peuvent provoquer des dommages uniquement au 
niveau de la peau ou des parties extérieures du corps, tandis que les rayons X de forte énergie 
peuvent pénétrer dans le corps jusqu’aux organes internes. Une forte dose aiguë administrée 
en une fois aurait un effet plus important que la même dose administrée dans le temps sous 
forme de fractions incrémentielles. 
 
Dans les environnements médicaux, le risque d’exposition aux rayonnements peut être 
minimisé grâce aux précautions suivantes : 

• Éviter toute exposition inutile aux rayonnements. 
• Utiliser des doses au niveau le plus bas qu’il soit raisonnablement possible d’atteindre 

(ALARA). 
• Suivre les instructions d’utilisation des fabricants d’équipements. 
• Suivre les instructions de maintenance préventive des fabricants d’équipements. 
• Utiliser un blindage approprié. 

 
 
ALARA 

Le concept ALARA repose sur l’hypothèse selon laquelle toute dose de rayonnement, aussi 
faible soit-elle, peut avoir un certain effet néfaste. Selon le principe ALARA, tous les moyens 
raisonnables permettant de réduire l’exposition sont mis en œuvre. 

Il existe trois règles générales pour réduire l’exposition d’une personne à tout type de 
rayonnement ionisant : 

1. Réduire la durée de votre exposition à la source de rayonnement.  
• La réduction du temps d’exposition permet de diminuer la dose de rayonnement. 

2. Augmenter la distance entre vous et la source de rayonnement. 
• L’augmentation de la distance par rapport à une source de rayonnement réduit 

considérablement la dose de rayonnement. 
• En doublant la distance d’une source de rayonnement, on obtient un quart du 

débit de dose. 
• En triplant la distance, on obtient un neuvième du débit. 

3. Augmenter le blindage entre vous et la source de rayonnement.  
• L’utilisation d’un blindage approprié permet de réduire considérablement la dose. 
• Le matériau utilisé et l’épaisseur du blindage dépendent de la source de 

rayonnement. 
• Le plomb constitue un matériau de blindage courant. 

 

Contactez votre responsable radioprotection pour connaître les règles et directives spécifiques 
à votre établissement. 

 2.5.0  
Gestion des 
risques 
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Radiation Safety Training and Reference Manual, California Institute of Technology, Training 
and Reference Manual, March 1995 (Revised June, 1996) 
 
Radiation Safety Manual(Revised March 2010), Stanford University, Veterans Affairs Palo 
Alto, Health Care System, Environmental Health and Safety, Stanford University, Stanford 
California 
 
Radiation and X-Ray Training - Environmental Health and Safety - University of North 
Carolina at Chapel Hill 
 
USF (University of Southern Florida) Radiation Safety – Research X-Ray Safety Manual, 
Radiation Safety Office – 2003 
 
University of Oklahoma Chemical Crystallography Lab, 11-APR-2011 
 
European Nuclear Society – Glossary of Nuclear Terms 
http://www.euronuclear.org/info/encyclopedia.htm 
 
United Nations Scientific Committee on the Effects of Atomic Radiation, UNSCEAR 1993, 
Report to the General Assembly, With Scientific Annexes,  
UNITED NATIONS PUBLICATION, Sales No. E.94.IX.2, ISBN 92-1-142200-0 
 
JEFFERSON LAB - Thomas Jefferson National Accelerator Facility (Jefferson Lab) 
 
Ionizing Radiation Effects and Their Risk to Humans, T.R. Goodman, MD Yale University 
School of Medicine, New Haven, CT 
 
IMAGE WISELY – Radiation Safety in Adult Medical Imaging 
http://www.imagewisely.org/Imaging-Professionals/Imaging-Physicians/Articles/Ionizing-
Radiation-Effects-and-Their-Risk-to-Humans.aspx 
 
Seibert 2004: Seibert J A “X-ray imaging physics for nuclear medicine technologists.” Part1: 
Basic principles of x-ray production J Nucl Med Technol32 139-47 
 
Shultis 2005: Shultis J K and Faw R E 2005 Radiation shielding technology Health Phys 88 
297-322 
 
Simpkin 1995: Simpkin D J 1995 Transmission Data for Shielding Diagnostic X-Ray 
Facilities Health Phys 68 704-709 
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Le système de radiographie d’échantillons numérique (DSR) Faxitron Core est un système 
d’imagerie radiologique numérique en armoire de bureau destiné à fournir une vérification 
rapide des biopsies au trocart. 
 
La possibilité de procéder à cette vérification directement dans la même salle de biopsie 
accélère le déroulement des opérations et réduit ainsi la durée nécessaire à l’examen du 
patient. La radiographie d’échantillons peut potentiellement limiter le nombre de rappels de 
patients. Le faible encombrement du Faxitron Core lui permet d’être installé dans des blocs 
opératoires ou des bureaux disposant de peu d’espace. 
 
Le système de radiographie d’échantillons numérique Faxitron Core utilise le logiciel 
Vision, un logiciel complet et puissant d’acquisition d’images et de manipulation de données. 
Le logiciel Vision gère l’acquisition des images radiographiques numériques, l’étalonnage, 
l’affichage des images, l’analyse et la manipulation des images, la base de données des 
patients, l’archivage et la transmission. Le logiciel Vision constitue la partie centrale de ce 
système. Le logiciel Vision est conforme à la norme DICOM 3.0 (Digital Imaging and 
Communications in Medicine) et comprend les fonctions d’impression et de stockage DICOM. 
Il suit également le protocole MWL (Modality Work List). 
 
 
 
Version DICOM 
 
Hologic utilise la dernière norme DICOM : 
ACR-NEMA Digital Imaging and Communications in Medicine (DICOM) v3.0, version finale, 
août 1993. 
 
Et est conforme à : 
NEMA PS 3.1 — 3.20 (2016), Digital Imaging and Communications In Medicine Set. 
 
 
Classes de stockage 
 
Le système DR Faxitron fournit une conformité standard à la classe DICOM V3.0 SOP 
suivante en tant que SCU. 
 
Classe SOP du SCU 
 

Classe SOP UID de la classe SOP 

Computed Radiography Image Storage SOP 1.2.840.10008.5.1.4.1.1.1 
Digital X-ray Image Storage Presentation 1.2.840.10008.5.1.4.1.1.1.1 
Digital X-ray Image Storage Processing 1.2.840.10008.5.1.4.1.1.1.1.1 
Digital X-ray Mammography Image Storage Presentation 1.2.840.10008.5.1.4.1.1.1.2 
Digital X-ray Mammography Image Storage Processing 1.2.840.10008.5.1.4.1.1.1.2.1 
Study Root Query/Retrieve Info. Model -FIND 1.2.840.10008.5.1.4.1.2.2.1 
Patient Root Query/Retrieve Info. Model -FIND 1.2.840.10008.5.1.4.1.2.1.1 
Modality Worklist information Model-FIND 1.2.840.10008.5.1.4.31 
Greyscale Softcopy Presentation Storage 1.2.840.10008.5.1.4.1.1.11.1 

 
 
Pour plus de détails, consultez la déclaration de conformité « Full DICOM » enregistrée sur le 
système. Le fichier se trouve dans C:\Faxitron et un raccourci est fourni sur le bureau. 
 
Si nécessaire, une copie de la déclaration de conformité DICOM est disponible sur demande 
auprès de Hologic. 
 

 3.0.0 
Vue d’ensemble 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3.0.1 
Version DICOM 
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Entretien 
 
L’équipement Hologic ne contient aucune pièce réparable. Veuillez contacter votre représentant 
Hologic agréé pour toute réparation. 
 

États-Unis : +1.877.371.4372 

Europe : +32 2 711 4690 

Asie : +852 37487700 

Australie : +1 800 264 073 

Autres pays : +1 781 999 7750 

Courrier électronique : BreastHealth.Support@hologic.com 

 
Dépannage 
 
Consultez le manuel d’entretien de Faxitron Core, contactez votre représentant Hologic ou le 
service clientèle Hologic. 
 
 
CALENDRIER DE MAINTENANCE 
 
Consultez le manuel d’entretien de Faxitron Core, contactez votre représentant Hologic ou le 
service clientèle Hologic. 
 
 
 
 
 
 

 3.0.2 
Entretien et 
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DISTANCES SOURCE-IMAGEUR (SID) et SOURCE-OBJET (SOD) : 

• Du haut de la caméra à l’imageur : 0,230 pouce (5,8 mm). 
• De la cible du tube à l’imageur :  12,90 pouces (327,66 mm). 
• De la cible du tube à la position de l’échantillon :  8,94 : (227,08 mm). 
• De l’imageur à la position de l’échantillon :  3,96 pouces (100,58 mm). 
• Agrandissement effectif :  1,44:1. 

 
POIDS : 40 livres (18 kg). 
 
CARACTÉRISTIQUES ÉLECTRIQUES : 120 V c.a. 60 Hz 150 W max ou 230 V c.a. 
50 Hz 150 W max. 
  
PRODUCTION DE CHALEUR : 500 BTU/h max. 
 
CYCLE D’UTILISATION DES RAYONS X : 50 %. 
 
CONTRÔLE DE L’EXPOSITION : automatique ou manuel. 

 3.1.0 
Spécifications 
 
 
Figure 3.0.1  
Dimensions et poids 
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Exigences | Conformité de Faxitron Core 

Il incombe à l’établissement ou à l’institution qui exploite ce système de veiller à ce que toutes 
les réglementations locales, régionales et fédérales concernant l’utilisation des appareils à 
rayonnement ionisant soient respectées. 

 

Limites en émission 

Le rayonnement émis par l’unité Faxitron Core ne dépasse pas une exposition de 0,3 milli-
Roentgen (mR) par heure en un point quelconque situé à 5 centimètres (cm) à l’extérieur de la 
surface externe. Pour les pays exigeant des valeurs d’émission mesurées à 10 cm des surfaces 
externes, le rayonnement ne dépasse pas 0,1 mR par heure à 10 cm. 

 

Verrouillages de sécurité 

Le système DR d’échantillons Faxitron Core est équipé de deux verrous de sécurité sur le 
tiroir à échantillons, le panneau d’accès avant et le panneau arrière pour empêcher la 
production de rayons X si ceux-ci ne sont pas fermés/installés. 

Bouton de démarrage 

Après l’interruption de la génération de rayons X par les verrouillages de sécurité, le bouton 
Start (Démarrage) du panneau avant reprendra la génération de rayons X lorsque le système 
sera prêt. 

Commande par clé 

Interrupteur à clé situé sur le panneau avant, qui nécessite d’insérer une clé et de la tourner 
dans le sens des aiguilles d’une montre jusqu’à la position « 3 heures » pour mettre sous 
tension le système de l’armoire. La clé ne peut pas être retirée en position « MARCHE ». 

Bouton d’arrêt d’urgence 

Le bouton d’arrêt d’urgence du panneau avant du Faxitron Core permet de mettre fin à la 
génération de rayons X. C’est un élément supplémentaire qui s’ajoute aux verrouillages de 
sécurité du tiroir du système. 

Voyants de génération de rayons X 

Le Faxitron Core est doté d’un voyant lumineux d’activation de rayons X sur le panneau avant 
et sur l’interface utilisateur graphique ; il émet également un signal sonore pendant la 
génération de rayons X. 

Accès au logiciel — Mot de passe facultatif 

L’utilisateur a la possibilité de mettre en place un « mot de passe » obligatoire pour ouvrir le 
logiciel Vision. Lorsque cette option est activée, le « mot de passe défini par l’utilisateur » doit 
être saisi pour ouvrir le logiciel Vision. Si le mot de passe correct n’est pas saisi, le logiciel se 
ferme. 

 

 

Système de commande des rayons X 

Le système de commande des rayons X se compose de l’électronique du système, des 
interrupteurs de verrouillage, du bouton de mise en marche des rayons X, du bouton d’arrêt 
d’urgence et du logiciel d’imagerie du système (Vision). 

Le système Faxitron Core est entièrement dépendant du logiciel d’acquisition d’images/de 
génération de rayons X.  

 3.2.0 
Exigences de 
conformité et 
mesures de 
sécurité 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3.3.0 
Système de 
commande des 
rayons X 
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Le logiciel et le micrologiciel de la carte de commande surveillent les conditions du système 
pour déterminer :  

1) Si l’acquisition d’images est autorisée. 
2) Les paramètres d’acquisition (niveau d’énergie et durée).  
3) Si l’acquisition d’images doit être interrompue. 
4) Quels sont les messages qui doivent être affichés, le cas échéant. 
5) Les voyants appropriés à activer. 

Les conditions suivantes doivent être réunies pour qu’il y ait acquisition d’images/génération de 
rayons X : 

1) Le logiciel Vision doit être ouvert. 
2) Le système doit être armé — les données du patient saisies. 
3) Les interrupteurs de verrouillage doivent être fermés. 
4) La carte de commande doit communiquer avec le logiciel du système (Vision). 
5) L’imageur numérique doit communiquer avec le logiciel du système. 
6) Le bouton d’activation de rayons X doit être enfoncé. 

Si les conditions ci-dessus sont remplies : le logiciel détermine les paramètres d’acquisition de 
l’image (niveau d’énergie et durée), et le logiciel envoie ces paramètres à la carte de 
commande. Le contrôleur traite le signal et l’achemine vers le HVPS (bloc d’alimentation haute 
tension). Si le circuit haute tension est actif, le HVPS génère une haute tension qui est envoyée 
au tube à rayons X — les rayons X sont générés. Des voyants et des messages sont activés 
pour informer l’utilisateur que l’acquisition d’images/la génération de rayons X est en cours. 

Si, à un moment quelconque au cours de l’acquisition d’images, un verrou est ouvert, 
l’acquisition sera interrompue et les indications et messages appropriés s’afficheront. 

 

Blindage 
Le système Faxitron Core est conçu pour générer des énergies de rayonnement ionisant de 
30 keV ou moins. 

L’acier inoxydable utilisé dans la fabrication de la chambre à rayons X de Faxitron Core est un 
matériau à haute teneur en Z qui absorbe efficacement presque 100 % du rayonnement ionisant 
à ce niveau d’énergie.  

Aucun blindage supplémentaire n’est nécessaire. 

Atténuation 
Le faisceau primaire du tube à rayons X de Faxitron Core est dirigé vers le sol du système. Tout 
faisceau réfléchi ou diffusé sera absorbé par le haut de la chambre à rayons X, les parois et la 
façade du tiroir. 

Les mesures typiques du rayonnement de fond à l’usine de fabrication de Hologic sont de  
0,1 µSv/h (0,01 mR/h). 

Les mesures de dose sont prises à des niveaux d’énergie de 30 keV avec un bloc acrylique de 
6 mm dans le trajet du faisceau primaire pour représenter les niveaux d’énergie maximum du 
système et la diffusion maximum du faisceau. Les mesures sur les surfaces accessibles sont 
généralement comprises entre 0,1 et 0,5 µSv/heure (0,01 et 0,05 mR/h). 

 

Hologic préconise de suivre le principe ALARA (niveau le plus bas qu’il soit raisonnablement 
possible d’atteindre). Utiliser des niveaux d’énergie ne dépassant pas ce qui est nécessaire 
pour effectuer la tâche. L’utilisation de l’AEC, contrôle automatique de l’exposition, garantit que 
les niveaux d’énergie des rayonnements ionisants les plus faibles possible seront générés pour 
obtenir une qualité d’image optimale. Lorsque l’AEC est activé, le système prend un court 
échantillon d’exposition à un niveau d’énergie et une durée prédéterminés. Le logiciel évaluera 
l’échantillon d’image et calculera les meilleurs réglages d’énergie et de durée. 

 3.3.0 Suite 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3.4.0 
Blindage et 
atténuation  
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EXIGENCES RÉGLEMENTAIRES 

Il incombe à l’établissement ou à l’institution qui exploite ce système de veiller à ce que toutes 
les réglementations locales, régionales et fédérales concernant l’utilisation des appareils à 
rayonnement ionisant soient respectées. 

 

Avertissements 

• Veuillez lire attentivement les instructions avant d’utiliser le système. 

• N’utilisez pas le système d’une manière autre que l’utilisation prévue, comme décrit dans ce 
manuel. En cas de doute, contactez Hologic ou votre distributeur agréé. 

• Tous les cordons d’alimentation ne sont pas prévus pour la même puissance. N’utilisez pas 
d’autre cordon d’alimentation avec ce système que celui fourni. N’utilisez pas le cordon 
d’alimentation de ce système sur un autre équipement. 

• Ce système a été testé conformément aux normes internationales les plus exigeantes ; 
toutefois, il est recommandé de contacter les autorités nationales en ce qui concerne les 
exigences opérationnelles locales. 

• Ce système n’est pas destiné à une utilisation publique. Il doit être situé dans une zone où le 
grand public ne peut pas accéder au système sans la présence d’un opérateur. 

• L’utilisation de commandes ou de réglages pour effectuer des procédures autres que celles 
spécifiées dans le présent document peut entraîner une exposition à un rayonnement 
dangereux. 

 

Précautions générales 

Les précautions suivantes doivent être prises pour éviter d’endommager votre système Faxitron 
Core : 

• Ne connectez ou déconnectez jamais les câbles de communication et/ou d’alimentation 
lorsque le système de caméra est sous tension. Des dommages au détecteur CMOS ou à 
l’électronique de la caméra peuvent survenir si les câbles sont connectés/déconnectés alors 
que l’appareil est sous tension. 

• Le système de la caméra est fragile et des précautions doivent être prises pour ne pas 
endommager la caméra. Le système de la caméra ne doit jamais être malmené, heurté, 
cogné ou laissé tomber. 

• Le système Faxitron Core dispose d’un mode d’étalonnage. L’étalonnage doit être effectué 
quotidiennement pour assurer le bon fonctionnement du système. Reportez-vous aux 
Sections 5 et 6 de ce manuel pour la procédure d’étalonnage. 

• Assurez-vous que le tiroir à échantillons est complètement fermé avant d’éteindre l’unité. 

• Assurez-vous que le tiroir à échantillons est propre et exempt d’échantillons et/ou de tout 
résidu avant d’éteindre l’unité. 

 

 4.0.0 
Avertisse-
ments et 
précautions 
du système 
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Connexions interopérables 

Le système Faxitron Core peut fonctionner comme un dispositif autonome sans aucune entrée 
ou sortie vers d’autres dispositifs. Les images peuvent être capturées, stockées et examinées 
directement sur le système. 

Toutefois, le système est livré avec plusieurs interfaces. La principale interface est la connexion 
réseau qui permet au système d’être connecté à un système d’archivage et de transmission 
d’images (PACS, Picture Archiving and Communication System). Les images peuvent ensuite 
être transmises au format DICOM du dispositif directement au réseau de l’établissement via 
notre logiciel. Voir Section 6 pour plus de détails sur la version DICOM. Seuls des employés de 
Hologic ou le personnel informatique qualifié de l’établissement de l’utilisateur doivent 
configurer cette communication. 

Les connexions du système et leur utilisation prévue sont indiquées ci-dessous. Aucun autre type 
de dispositif ne doit être connecté au système Faxitron Core sans l’approbation de Hologic. 

 4.0.0 Suite 

Raccordement Usage Type de 
dispositif 

Utilisateur prévu 

Port Ethernet à 
l’arrière 

Pour stocker des images radiographiques 
sur un réseau de stockage de données. 

PACS ou 
stockage en 
réseau 

Configuré par le personnel 
de Hologic ou du service 
informatique de l’établissement. 
Utilisé par les cliniciens.  

Port Ethernet à 
l’arrière 

Pour permettre une connexion à distance 
de l’équipe d’entretien de Hologic, à des fins 
de diagnostic et de réparation du système.  

Connexion 
internet en 
réseau 

Personnel de Hologic ou 
du service informatique 
de l’établissement 

Port USB à 
l’avant 

Pour transférer des images à partir du 
dispositif. Il ne doit être utilisé que si le 
PACS ou le réseau n’est pas disponible.  

Périphérique de 
stockage USB 
(clé USB) 

Cliniciens ou personnel du 
service informatique ayant un 
accès autorisé au système.  

Port USB à 
l’avant 

Pour assurer la maintenance et l’entretien 
du système, il peut être nécessaire de 
copier les fichiers sur l’ordinateur et à partir 
de celui-ci. Par exemple, les mises à jour du 
logiciel ou les fichiers journaux.  

Périphérique de 
stockage USB 
(clé USB) 

Personnel de Hologic ou 
du service informatique 
de l’établissement. 

Port USB à 
l’arrière 

Pour permettre la connexion d’une 
imprimante. Le logiciel Vision permet de 
connecter une imprimante DICOM ou une 
imprimante standard compatible Windows.  

Imprimante 
DICOM ou 
Windows 

Cliniciens ou personnel du 
service informatique de 
l’établissement. 

Cybersécurité 

La sécurité des dispositifs est une responsabilité partagée entre Hologic et les établissements 
de santé. L’absence de maintien de la cybersécurité peut entraîner une compromission des 
fonctionnalités des dispositifs, une perte de disponibilité ou d’intégrité des données (médicales 
ou personnelles) ou l’exposition d’autres dispositifs ou réseaux connectés à des menaces de 
sécurité. Hologic effectue un ensemble de contrôles de cybersécurité pour garantir la 
cybersécurité de ses unités et pour assurer leur fonctionnalité et leur sécurité. 

Toutes nos unités utilisent les systèmes d’exploitation standard Windows. Lors de l’installation, 
nous recommandons à l’établissement de mettre en place toutes les mesures de sécurité 
nécessaires définies par ses propres exigences internes, comme il le ferait pour tout autre PC 
connecté au réseau. 

L’établissement peut configurer le système d’exploitation Windows avec tous les protocoles de 
réseau et les autorisations nécessaires. Par exemple, ils peuvent ajouter : 

• ID utilisateur et mots de passe. 
• Autorisation par couches avec authentification appropriée. 
• Restrictions sur les installations de logiciels. 
• Exigences relatives au contenu de confiance, y compris la vérification de la signature 

du code. 
• Configuration des mises à jour de Windows, y compris les versions de sécurité. 
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En outre, notre logiciel d’imagerie (Vision) peut être protégé par un mot de passe, de sorte que 
certains utilisateurs peuvent accéder au système d’exploitation sans pouvoir ouvrir le logiciel 
Vision. 

L’unité est livrée avec une clé physique qui permet d’activer le système de radiographie. Cela 
permet au système d’être verrouillé, de sorte que même si l’on accède au logiciel, aucune 
radiographie ne peut être lancée. 

Cette unité est conçue pour être utilisée soit comme une unité autonome, soit pour être connectée 
au PACS interne de l’établissement ou à un autre réseau en boucle fermée. Elle n’est pas 
destinée à être connectée à Internet, à moins que (a) l’établissement reçoive des instructions 
spécifiques de la part de Hologic, ou que (b) l’établissement prenne des précautions adéquates 
pour assurer sa cybersécurité face aux menaces liées à sa connexion à Internet. 

Hologic développera des mises à jour ou des correctifs pour le logiciel Hologic afin de continuer 
à assurer la sécurité du produit, selon les besoins tout au long du cycle de vie de l’unité. 

Des mesures de sécurité supplémentaires, notamment le cryptage, peuvent être mises en œuvre 
et Hologic peut travailler avec le département informatique des établissements pour réduire le 
risque pour les patients à la suite d’une violation de la cybersécurité. 

Événements liés à la cybersécurité 

Si un événement lié à la cybersécurité se produit, déconnectez le système du réseau et 
contactez immédiatement Hologic. Nous travaillerons avec votre département informatique 
pour résoudre le problème. 

Un événement lié à la cybersécurité peut être détecté de plusieurs façons : 

• Fonctionnement et/ou connexion au réseau plus lents que la normale. 
• Fenêtres contextuelles suspectes ou page d’accueil modifiée dans le navigateur 

Internet. 
• Mot(s) de passe inopérant(s). 
• Programmes non identifiés dans le menu de démarrage ou dans la barre d’état du 

système. 
• Données manquantes, corrompues ou altérées. 

Nettoyage 
Chambre interne 

Les échantillons contenant des échantillons biologiques peuvent abriter des agents infectieux 
dangereux pour votre santé. Suivez les procédures de biosécurité appropriées ; portez des 
gants lors de la manipulation des échantillons de tissus ou de tout matériau avec lequel ils sont 
entrés en contact. 

La seule partie de la chambre à rayons X accessible pour le nettoyage est le tiroir à échantillons. 
Vous pouvez essuyer doucement le tiroir à échantillons à l’aide d’un chiffon doux non pelucheux 
humidifié avec de l’alcool isopropylique à 70–90 % ou avec de l’hypochlorite de sodium dilué 
(5,25–6,15 % d’eau de Javel domestique diluée à 1:500 fournit la concentration appropriée).  

• N’utilisez pas d’abrasifs ou de solvants agressifs. 
• Ne frottez pas la zone d’image en retrait du tiroir, car cela pourrait rayer la surface et 

créer des artefacts d’image. 
• Testez les produits de nettoyage sur de petites zones non visibles du tiroir pour vérifier 

qu’ils n’endommagent pas le matériel. 

Surfaces externes 

Essuyez régulièrement les surfaces externes avec de l’alcool isopropylique, de l’hypochlorite 
de sodium ou du savon doux et de l’eau. (Voir ci-dessus pour les concentrations appropriées.)  
Ne trempez pas ou n’inondez pas les surfaces et n’utilisez pas d’abrasifs qui pourraient rayer 
les surfaces. Ne laissez pas l’humidité entrer en contact avec les composants électriques du 
système. Testez les produits de nettoyage sur une petite zone non visible des capots pour 
vérifier qu’ils n’endommagent pas le matériel. 

 4.0.0 Suite 
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Configuration du système 

Le Faxitron Core doit être configuré par un représentant autorisé de Hologic, Inc. 

 

Inspection des boîtes 

Le système Faxitron Core est livré dans une (1) boîte en carton. La boîte contient l’armoire à 
rayons X Faxitron Core, l’ordinateur, l’écran, le cordon d’alimentation, le câble vidéo, les câbles, 
les cordons, la documentation, les clés de l’armoire à rayons X et 25 plateaux d’échantillons.  

Demandez à l’agent de transport de déposer la boîte dans une zone à l’abri du vol, des 
dommages ou des conditions environnementales extrêmes, jusqu’à ce que le représentant 
autorisé de Hologic, Inc. puisse installer le système. 

Vérifiez que la boîte n’est pas endommagée. Si vous constatez des dommages, contactez 
Hologic au 1-800-447-1856. 

 

Levage et transport des boîtes 

Attention :  la boîte pèse environ 80 livres (36,3 kg). La boîte doit être maintenue en position 
verticale, comme indiqué par les étiquettes. Faites preuve de prudence lors de vos 
déplacements pour éviter de vous blesser et d’endommager le système. 

 
Déballage et mise en place du système 
Le système Faxitron Core doit être déballé et installé sur place par un représentant autorisé de 
Hologic, Inc. 

 

Emplacement 

Laissez au moins 6 pouces (15 cm) d’espace libre derrière l’armoire, une fois installée, pour 
permettre une bonne ventilation et l’accès au cordon d’alimentation et aux câbles. 

 

Conditions environnementales 
En fonctionnement : 

Température :  15,5 à 30 degrés C ou 60 à 86 degrés F.  

Humidité relative :  < 75 pour cent.  

Stockage et transport : 

Température :  -20 à 50 degrés C ou -4 à 122 degrés F. 

Humidité relative :  < 75 pour cent. 

L’équipement a été conçu pour les conditions suivantes : 

• Utilisation intérieure. 
• Altitude de 2 000 mètres (6 562 pieds). 
• Degré de pollution 2. 
• Surtension, catégorie II. 

 4.1.0 
Configuration 
du système 
d’échantillons 
Faxitron Core 
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CARACTÉRISTIQUES ÉLECTRIQUES :  120 V c.a. 60 Hz 150 W max OU 
240 V c.a. 50 Hz 150 W max. 

PRODUCTION DE CHALEUR :  500 BTU/h max. 

CYCLE D’UTILISATION DES RAYONS X :  50 %. 

SÉCURITÉ CONCERNANT LE RAYONNEMENT :  Reportez-vous à la Section 2 de ce 
manuel. 

 

Le Faxitron Core a été conçu comme un système fixe à installer sur un bureau, un comptoir ou 
une table. 

Déplacement du système Faxitron Core — Non recommandé. 
Une fois placé à son emplacement définitif, il est recommandé de ne pas déplacer le système 
Faxitron Core. 

Le système Faxitron Core n’est pas conçu comme une unité portable. À l’heure actuelle, aucun 
chariot n’est fourni, de sorte que le système informatique sera également placé sur une surface 
non portative. 

 

Attention :  l’armoire à rayons X Faxitron Core pèse environ 40 livres (18 kg) et n’est pas 
conçue pour être soulevée et transportée. Il s’agit d’un instrument de précision qui 
nécessite une manipulation appropriée. N’essayez pas de soulever ou de 
transporter le système. 

Merci de ne pas bloquer la zone située derrière ou immédiatement devant l’unité, car cet espace 
ouvert est nécessaire pour la ventilation du système et du PC. Une ventilation adéquate est 
assurée à l’arrière du système tant qu’aucun objet n’est placé entre l’unité et le mur de la prise 
de courant du système. 

Veillez à ce qu’il y ait une surface plane, de niveau et sans danger devant le système pour 
permettre au personnel d’accéder en toute sécurité à la porte du compartiment à échantillon, 
au clavier, à l’écran de l’ordinateur, et au panneau de commande du système. 

 

Remarque : prévoyez suffisamment d’espace à côté du système pour pouvoir accéder 
facilement au cordon d’alimentation du système. 

 

Attention : si vous devez déplacer le système Faxitron Core : 
• Veillez à ce que tous les composants soient complètement hors tension. 
• Débranchez les cordons d’alimentation de la prise de courant. 
• Débranchez tous les cordons et câbles d’interconnexion (c’est-à-dire le câble à 

fibres optiques). 
• Faites attention lorsque vous déplacez l’armoire à rayons X Faxitron Core. 

 

Avertissement :  le cordon d’alimentation du système Faxitron Core est fourni avec une prise 
de terre. S’il n’y a pas de prise de courant appropriée correspondant à la 
fiche du cordon d’alimentation du système, faites appel à un personnel 
qualifié pour fournir une prise de courant appropriée. N’essayez pas de 
modifier vous-même la fiche ou la prise. 

 
Avertissement :  pour éviter tout dommage à l’unité et/ou tout contact avec des tissus 

infectieux, assurez-vous que le Faxitron Core est soigneusement nettoyé et 
correctement emballé avant de le retirer du service, de le transporter ou de 
le jeter. 

  4.1.0 Suite 
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Avant de mettre le système sous tension, veuillez vous assurer que les cordons d’alimentation 
sont bien branchés dans l’armoire Faxitron Core, l’ordinateur et l’écran avant de brancher les 
cordons dans les prises de courant de l’établissement. En outre, si nécessaire, branchez un 
câble réseau Cat5 ou Cat6 sur l’ordinateur Faxitron Core et la connexion réseau de 
l’établissement. 

Reportez-vous à la Section 4, Installation et configuration, du présent manuel, ainsi qu’aux 
guides d’installation et de démarrage rapide fournis avec votre système Faxitron Core. 

Procédures d’imagerie de base 
 
Avertissement :  l’utilisation du Faxitron Core d’une manière autre que celle décrite dans ce 

manuel peut entraîner un mauvais fonctionnement de l’équipement ou des 
blessures corporelles. 

Avertissement :  utilisez des contenants ou des gants agréés afin d’éviter tout contact avec 
des échantillons de tissus de patients potentiellement dangereux. 

Résumé de la séquence d’images 
 
Consultez le guide de démarrage rapide de Faxitron Core pour obtenir un résumé du 
fonctionnement du système. 

• Ouvrez le tiroir à échantillons (appuyez sur le bouton noir). 
• Placez le(s) échantillon(s) dans un récipient pour échantillon fourni par Hologic, Inc. ou par 

votre établissement et placez-le à l’intérieur du tiroir du Faxitron Core. 
• Fermez le tiroir à échantillons (appuyez sur le bouton noir). 
• Choisissez ou entrez un patient dans le logiciel Vision et lancez une acquisition d’images à 

partir du logiciel. 
• Appuyez sur le bouton Start (Démarrer) (vert) du panneau de commande de Faxitron Core 

ou du logiciel. L’exposition aux rayons X débutera. 
• Attendez que l’image s’affiche. 
• Utilisez la souris pour déplacer le curseur sur l’image affichée et déplacez le curseur vers le 

haut et le bas pour les niveaux de luminosité/obscurité ou vers la gauche et la droite pour les 
niveaux de contraste faible/élevé. Déplacez le curseur jusqu’à ce que l’image atteigne le 
niveau souhaité. 

• Répétez le processus pour les autres échantillons. 

Voir la Section 5.2 pour obtenir des instructions de fonctionnement plus détaillées. 

Voir la Section 6 du manuel de l’utilisateur pour le fonctionnement du logiciel avancé.  

 5.0.0 
Aperçu du 
démarrage rapide 
 
 
 
 
 
 
Figure 5.0.1  
Panneau avant du Faxitron Core  
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Informations générales relatives au démarrage 

La mise sous tension (démarrage du système) est effectuée une seule fois au début de 
l’utilisation du système. Il est recommandé, une fois la séquence de mise sous tension 
effectuée, de laisser le système allumé le reste de la journée si vous prévoyez de l’utiliser à 
nouveau. 
 

Protocole applicable à la séquence de démarrage du système 

Mise sous tension du système : 

• Allumez l’ordinateur et l’écran et laissez-les démarrer complètement sous Windows. 

• Placez l’interrupteur situé à l’arrière de l’armoire Faxitron Core 
sur la position « MARCHE ». Voir Figure 5.1.1. 

• Tournez la clé située à l’avant de l’armoire Faxitron Core sur 
« MARCHE » (dans le sens des aiguilles d’une montre 
jusqu’à la position correspondant à trois heures). Voir 
Figure 5.1.2. 

• Vérifiez qu’il n’y a rien dans le tiroir à échantillons du Faxitron Core. 

 

 

 

 

 

Démarrage du logiciel : 

• « Double-cliquez » sur l’icône Vision sur le bureau de Windows. 

• Une boîte de dialogue apparaîtra brièvement pour indiquer que le 
logiciel a été initialisé et qu’il est en cours de chargement. 

• Le logiciel s’ouvrira sur l’écran « Home Menu » (Menu d’accueil) ou 
« Calibration » (Étalonnage) selon le temps écoulé depuis la fin du 
dernier étalonnage. 

Le logiciel s’ouvrira au menu d’accueil si un étalonnage a été effectué au cours des 12 dernières 
heures. 

Pour garantir une qualité d’image optimale, Hologic recommande d’étalonner le système lors 
de la mise en service initiale chaque jour ou si le système a été déplacé.  

 

Pour lancer manuellement un étalonnage, cliquez sur le bouton Calibrate (Étalonner) dans le 
menu d’accueil, puis cliquez sur le bouton Start Calibration (Démarrer l’étalonnage). Le logiciel 
reviendra au menu d’accueil lorsque l’étalonnage sera terminé. Voir les Figures 5.1.4 et 5.1.5. 

 

 

 

 

 

 5.1.0 
Séquence de mise 
en marche  
 

 

5.1.1 
Démarrage du 
système  
 
Figure 5.1.1  
Interrupteur principal  
 

 
 
 
 
 

Figure 5.1.2  
Interrupteur à clé 
 
 
 
 
 
 
 

Figure 5.1.3  
Icône VISION sur le bureau 
 
 

 

 

 

 

 

 
 
 

 

 
Figure 5.1.4  
Bouton Start Calibration 
(Démarrer l’étalonnage) 
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Étalonnage : 
REMARQUE : pour une qualité d’image optimale, il est recommandé d’étalonner le système au 
moins une fois par jour, avant la première utilisation. 
 

• Le logiciel s’ouvrira à l’écran d’étalonnage s’il s’est écoulé 12 heures depuis le dernier 
étalonnage. 

• Appuyez sur le bouton Start Calibration (Démarrer l’étalonnage) et patientez jusqu’à 
ce que le système termine l’étalonnage. 
 
 
 
 
 
 
 
 
 
 
 
 

• La boîte de dialogue d’étalonnage s’ouvre et indique la progression de l’étalonnage. 
 
 
 
 
 
 
 
 
 
 
 
• La boîte de dialogue se ferme lorsque l’étalonnage est terminé. Le logiciel se rendra à 

la page du menu d’accueil.  

 5.1.2 
Étalonnage 
 
 
 
 
 
Figure 5.1.5  
Bouton Start Calibration 
(Démarrer l’étalonnage) 
 
 
 
 
 
 
 
 
Figure 5.1.6  
Boîte de dialogue d’étalonnage 
des rayons X 
 
 
 

 
 
Démarrage d’une procédure d’imagerie 
• À partir de la page du menu d’accueil (voir Figure 5.1.4), sélectionnez le bouton Start 

procedure (Démarrer la procédure). 

• L’utilisateur aura le choix entre Select from Work List (Sélectionner dans la liste de travail), 
Manual Entry (Saisie manuelle), Select from Database (Sélectionner dans la base de 
données) ou Continue with current patient (Continuer avec le patient actuel). Voir 
Figure 5.2.1. 

 

 5.2.0 
Acquisition 
d’images 
 
 
 

Figure 5.2.1 
Boutons de saisie des données 
du patient 
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• Pour saisir manuellement une nouvelle procédure, sélectionnez le bouton Manual Entry 
(Saisie manuelle). 

REMARQUE :  cette Section ne couvre que la « saisie manuelle » des données du 
patient, les autres options sont traitées dans la Section 6 de ce manuel. 

• La boîte de dialogue « Patient Information Editor » (« Éditeur d’informations sur le patient ») 
s’ouvre. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Remarque : les champs obligatoires sont indiqués par un 
astérisque blanc (*). Les champs obligatoires par défaut sont : 
Patient Name (Nom du patient), Patient ID (ID du patient), 
Accession Number (Numéro d’ordre) et Laterality (Latéralité). 

 
• Saisissez tous les champs obligatoires. Le bouton Accept (Accepter) ne sera pas actif si l’un 

des champs obligatoires manque. L’utilisateur peut remplir d’autres champs s’il le souhaite. 

 

Remarque : la date doit être inscrite dans le format aaaa/mm/jj (par exemple, 1962/08/13). 

 

• Sélectionnez Accept (Accepter) pour activer l’acquisition d’images. 

• Le système est prêt à acquérir des images. 

 5.2.1 
Saisie manuelle 
des données du 
patient 
 
 

Figure 5.2.2  
Éditeur d’informations sur 
l’imagerie 
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Prendre une image/démarrer une exposition aux rayons X 
Pour prendre une image radiographique avec le système Faxitron Core : 

• Ouvrez le tiroir de la chambre à rayons X en appuyant sur le bouton noir et placez le 
plateau du Faxitron Core avec les échantillons dans le tiroir. Fermez le tiroir en appuyant à 
nouveau sur le bouton noir.   

• Appuyez sur le bouton vert de Start X-Ray (Démarrer les rayons X) sur le panneau de 
commande ou le logiciel. 

• Attendez que l’image s’affiche. 
 

 

 

 

 

 

 

 

 

 
 

 
 
REMARQUE :  le mode de radiographie par défaut du Faxitron Core est Full Auto (Entièrement 

automatique). Le système prendra deux radiographies, la première pour 
déterminer les paramètres optimaux et la seconde pour prendre l’image. Les 
réglages utilisés pendant les expositions s’afficheront sur l’écran LCD des 
armoires. 

Le logiciel Vision est configuré pour enregistrer automatiquement l’image dans la base de 
données Faxitron sur le disque local de l’ordinateur du système. L’utilisateur peut également 
enregistrer l’image sur le serveur des installations en cliquant sur l’icône « PACS ». Voir les 
Sections 6.4.1, 6.6.0 et 6.7.0 pour plus d’informations sur l’enregistrement des images. 

Pour plus d’informations sur le réglage des paramètres d’image, les commandes de rayons X 
et les options d’analyse et d’enregistrement, voir Section 6. 

 5.2.2 
Démarrage de 
l’exposition 
 
 
 
 
 
 
 
Figure 5.2.3 
Tiroir du Faxitron Core 
 
 
 
 
 
 
 
 
 
 

Quitter le logiciel VISION 
Cliquez sur le bouton Shut Down (Arrêter), puis sur OK. L’ordinateur s’éteindra. L’arrêt peut 
être sélectionné sur l’écran d’accueil ou sur l’écran d’acquisition d’images à l’aide des boutons 
illustrés ci-dessous.  

 

     Bouton Shut Down (Arrêter) de l’écran d’acquisition. 

 

             Bouton Shut Down (Arrêter) du menu d’accueil. 

 

Éteindre l’armoire à rayons X Faxitron Core 
Une fois l’ordinateur éteint, mettez l’interrupteur à clé sur Arrêt (clé en position verticale). 

 
5.2.3 
Arrêt du système 
 
 
Figures 5.3.1 et 5.3.2 
Boutons d’arrêt du système et de 
sortie du programme 
 
 

 

Bouton du 
tiroir 

Bouton des 
rayons X 

Bouton  
« Start X-Ray » 
(Démarrer les 

rayons X) à l’écran 
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Le logiciel Vision est un ensemble complet d’acquisition et de traitement d’images, conçu 
exclusivement pour fonctionner avec les générateurs de rayons X de Hologic (tels que les 
systèmes VersaVision, Faxitron Path, Faxitron Core et Faxitron OR). En plus des fonctions 
d’acquisition et de traitement, le logiciel offre un module de base de données étendue, qui 
permet à l’utilisateur de commander, de gérer l’archivage, le stockage, le classement et la 
récupération des images. Le logiciel est également conforme à la norme DICOM (Digital 
Imaging and Communications in Medicine), ce qui permet d’enregistrer et d’imprimer les images 
des patients au format DICOM 3.0. Le logiciel a été préinstallé sur l’ordinateur qui était livré 
avec votre système à rayons X. 
 
L’étalonnage du système est requis au début de chaque nouvelle journée d’utilisation du 
système, pour garantir la meilleure qualité d’image. L’utilisateur du système peut également 
effectuer un étalonnage à tout moment pour garantir une qualité d’image optimale. 
 
Après l’étalonnage, le menu d’accueil s’affiche, ce qui permet de naviguer vers toutes les autres 
zones du logiciel. Pour faciliter l’utilisation, des boutons d’application sont fournis. Voir 
Figure 6.0.1. Ces boutons se trouvent au centre de l’écran. Les descriptions et définitions des 
boutons sont présentées dans les sections suivantes de ce manuel.  
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Protocole de séquence 
 
Cette séquence de démarrage doit être respectée pour assurer le bon fonctionnement du 
système et la qualité de l’image : 

• Allumez l’armoire Faxitron Core à l’aide de l’interrupteur situé à l’arrière de l’armoire. 
(L’interrupteur se trouve à côté de la prise du cordon d’alimentation.) Faites basculer sur « I » 
pour mettre en position « MARCHE » et sur « 0 » pour mettre en position « ARRÊT ». 

• Mettez le système Faxitron Core sur « MARCHE » en insérant la clé Faxitron Core dans 
l’interrupteur à clé situé sur le panneau avant et en la tournant dans le sens des aiguilles 
d’une montre jusqu’à la position « 3 heures ». Remarque : la clé ne peut pas être retirée dans 
cette position. 

• Allumez l’ordinateur et l’écran. 
• Double-cliquez avec le bouton gauche de la souris sur l’icône Vision 

Software (logiciel Vision) (situé sur le bureau de Windows) si Vision ne 
démarre pas automatiquement. Voir Figure 6.1.1. Une boîte de dialogue 
apparaîtra brièvement pour indiquer que le logiciel a été initialisé et qu’il 
est en cours de chargement. 

• Le logiciel Vision s’ouvrira au menu d’accueil (voir Figure 6.0.1) ou à la 
page d’étalonnage (voir Figure 6.2.2) en fonction du temps écoulé depuis 
le dernier étalonnage du système. 

• Reportez-vous à la Section 6.2.0 « Aperçu de l’étalonnage de la caméra » pour les protocoles 
d’étalonnage. 

 6.0.0 
Aperçu du logiciel 
Vision 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 6.0.1  
Logiciel Vision.  
Menu d’accueil (écran de 
démarrage)  
 
 
 
 
 
 
 
 
 
 
 
 

6.1.0 
Démarrage du 
logiciel  
 
 
 
 
 
 
 
 
Figure 6.1.1  
Icône du bureau du logiciel Vision 
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Introduction à l’étalonnage 
 
Pour optimiser la qualité de l’image, le logiciel Vision et le matériel nécessitent un étalonnage 
périodique. Cet étalonnage nécessite l’acquisition d’images de référence.  
 
Lors de la mise en service initiale du système ou à n’importe quel moment souhaité par 
l’utilisateur, un étalonnage du système peut être demandé et effectué. Il est recommandé 
d’effectuer les étalonnages suivants toutes les douze (12) heures. 
 
Ces images d’étalonnage de référence sont utilisées pour étalonner une image radiographique 
« brute » pixel par pixel, afin de générer une image « corrigée » pour l’affichage. Les corrections 
d’image effectuées comprennent les corrections de gain, de décalage et de linéarité. 
 

Séquence d’étalonnage 
 
Pour plus de commodité, le logiciel Vision combine les nombreuses étapes de l’étalonnage en 
une étape unique. 
 
Lorsqu’un système à rayons X Hologic a été éteint pendant plus de douze (12) heures, le 
système demande automatiquement à être réétalonné. Il est fortement recommandé de 
réétalonner le système après une longue période d’inactivité ou après un déplacement du 
système d’une pièce à une autre, car les paramètres de température/humidité ambiante 
peuvent être différents.  
 
Pour étalonner le système à tout moment, cliquez sur le bouton 
Calibrate (Étalonner) dans le menu d’accueil de Vision (écran de 
démarrage), puis appuyez sur Start Calibration (Démarrer 
l’étalonnage). Voir les Figures 6.2.1 et 6.2.2. La boîte de dialogue 
affiche un message d’état pendant l’étalonnage. Voir Figure 6.2.3. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Pendant l’étalonnage, des rayons X peuvent être générés. Pendant la génération des rayons 
X, un bouton Stop X-Ray (Arrêter les rayons X) sera rendu visible pour permettre à l’utilisateur 
d’arrêter les rayons X par le biais du logiciel. 

 6.2.0 
Aperçu de 
l’étalonnage de la 
caméra 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 6.2.1  
Bouton Calibrate (Étalonner) du 
menu d’accueil 
 
 
 
 
 
 

Figure 6.2.2  
Bouton Start Calibration 
(Démarrer l’étalonnage) 
 
 
 
 
 
 
 
 
Figure 6.2.3  
État de l’étalonnage 
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Voici un résumé du protocole d’étalonnage avancé pour « Both » (Les deux) (champ plat et 
image) : 

Placez l’atténuateur uniforme sur le détecteur. Toute la surface du détecteur doit être recouverte 
par l’atténuateur. Pour obtenir des résultats optimaux, l’atténuateur doit être plus grand que la 
zone d’imagerie du détecteur. 

Depuis le menu d’accueil du logiciel d’imagerie, appuyez sur l’icône ^ en haut à droite pour 
faire apparaître le menu. Sélectionnez l’élément du menu déroulant « Tools » (Outils) dans le 
menu horizontal situé en haut de l’écran, puis passez de « Advanced Tools » (Outils avancés) 
à « X-Ray Calibration/Exposure Setup » (Étalonnage des rayons X/Configuration de 
l’exposition). 
 

 

 

 

 

 

 

 

 

 

 

 

 

 
REMARQUE :  les valeurs de kV, de temps d’exposition et d’ADU/s  

peuvent varier par rapport à celles indiquées. 

• Sous « X-Ray Generator and Exposure Settings » (Générateur de rayons X et paramètres 
d’exposition), saisissez le réglage en kV du générateur dans le champ approprié. 

• Laissez « Magnification » (Agrandissement) au réglage par défaut de 1,450. 
(L’agrandissement est réglé dans le système Faxitron Core.) 

• Sélectionnez le bouton « Set for » (Régler pour) « Both » (Les deux) dans la boîte de 
dialogue. 

• Laissez le réglage par défaut « user ADU target » (cible ADU utilisateur). L’exposition aux 
rayons X sera terminée lorsque le détecteur aura accumulé un niveau de signal moyen d’ADU 
acceptable pour votre générateur de rayons X. 

• Conservez le temps d’exposition par défaut du test et cliquez sur le bouton Acquire 
(Acquérir). Le système commencera automatiquement l’émission de rayons X et fera 
l’acquisition d’une image. 

• Lorsque l’exposition aux rayons X est achevée, cliquez sur le bouton Estimate/Calculate 
(Estimer/Calculer). 

• Enregistrez la valeur du temps d’exposition calculé « Time [s] » (Durée [s]). Le système 
calcule cette durée, et le nombre est grisé. 

• Saisissez la valeur du temps d’exposition calculé de « Time [s] » (Durée [s]) dans la zone de 
temps « Test Exposure » (Exposition test). Appuyez sur le bouton Acquire (Acquérir) pour 
lancer automatiquement les rayons X et obtenir une image. 

• Lorsque l’exposition aux rayons X est achevée, cliquez sur le bouton Estimate/Calculate 
(Estimer/Calculer). 

 6.2.0 Suite 
 
 
 
 
 
 

Figure 6.2.4  
Boîte de dialogue Générateur de 
rayons X et exposition 
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• Enregistrez la valeur du temps d’exposition calculé « Time [s] » (Durée [s]). 
• Saisissez à nouveau le temps d’exposition calculé dans le champ « Test Exposure » 

(Exposition test). 
• Cliquez sur le bouton Accept Settings (Accepter les paramètres). 
• Effectuez une procédure d’étalonnage standard, comme décrit dans la section « Aperçu de 

l’étalonnage de la caméra ». 
Il est possible que les utilisateurs expérimentés souhaitent régler les paramètres d’exposition « X-
Ray Cal (Flat-Field) » (Étalonnage des rayons X [champ plat]) et « Manual Image » (Image 
manuelle) indépendamment ou « Both » (Les deux) (champ plat et image manuelle), comme 
décrit précédemment. En sélectionnant la case « Flat Field » (Champ plat), le système détermine 
le temps d’exposition optimal pour l’acquisition d’images en champ plat avec le niveau ADU 
souhaité. En conséquence, la sélection de « Manual Image » (Image manuelle) déterminera le 
temps d’exposition optimal pour le système avec un objet qui atténuera les rayons X. Pour de 
meilleurs résultats, toute la zone d’imagerie du détecteur doit être recouverte par l’objet. 

Après avoir sélectionné « X-Ray Cal (Flat-Field) » (Étalonnage des rayons X [champ plat]) et 
« Manual Image » (Image manuelle) et une fois le niveau ADU réglé ; sélectionnez le bouton 
Acquire (Acquérir). Pour la sélection « Manual Image » (Image manuelle), il est souhaitable 
que l’objet ou l’atténuateur de rayons X soit dans le faisceau de rayons X. Appuyez sur le bouton 
Acquire (Acquérir) pour générer des rayons X et obtenir une image. Lorsque l’exposition aux 
rayons X est terminée, cliquez sur le bouton Estimate/Calculate (Estimer/Calculer). Le 
système calcule le temps optimal, et le nombre est grisé. Cliquez sur le bouton Accept Setting 
(Accepter le paramètre) pour enregistrer les « Exposure Settings » (Paramètres d’exposition) 
dans le fichier de configuration du système.  

Remarque : seuls les réglages ayant la case d’option sélectionnée sont enregistrés.  

Effectuez ensuite une procédure d’étalonnage standard, comme décrit dans la section « Aperçu 
de l’étalonnage de la caméra ». 

 

Il peut parfois être souhaitable d’incorporer les caractéristiques d’atténuation des rayons X d’un 
atténuateur uniforme dans les images d’étalonnage de référence en champ plat. Par exemple, 
si tous les objets qui doivent être balayés sont placés sur une mince plaque de plastique, les 
caractéristiques d’atténuation des rayons X de la plaque seront observées dans chaque image 
acquise. Dans ce cas, le fait de placer la plaque dans le faisceau de rayons X pendant 
l’acquisition de l’image d’étalonnage de référence en champ plat pourrait améliorer la qualité 
de l’image. 

 

Le bouton Start Procedure (Démarrer la procédure) (voir Figure 6.0.1) amène l’utilisateur à la 
page Patient Data Entry (Saisie des données du patient), qui propose différents moyens de 
saisie des données du patient. Si aucune liste de travail n’a été configurée, l’option sera grisée 
et seules les options Continue with Current Patient (Continuer avec le patient actuel), Manual 
Entry (Saisie manuelle), et Select from Database (Sélectionner dans la base de données) 
seront accessibles. Les options sont détaillées dans les sections suivantes. 
 

 6.2.0 Suite 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6.2.1 
Étalonnage avancé 
 
 
 
 

6.3.0 
Données du patient 
 
 
 
 
 
Figure 6.3.1 
Ecran de saisie des données du 
patient 
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Sélectionner dans la liste de travail  
(liste de travail distante de la modalité) 

Si une liste de travail a été configurée, l’utilisateur peut cliquer sur le bouton Select from Work 
List (Sélectionner dans la liste de travail) qui affichera la page illustrée à la Figure 6.3.2. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Les différents filtres sur la gauche peuvent être utilisés pour rechercher des procédures 
programmées pour l’entité d’application (AE) de la station de travail. Vérifiez que le titre de l’AE 
de la station de travail est défini, puis tout champ unique ou toute combinaison de champs peut 
être utilisé(e) comme filtre pour rechercher des procédures programmées pour cette AE. En 
sélectionnant le bouton Query (Interroger) situé dans le coin inférieur gauche, le tableau est 
rempli à nouveau avec les entrées correspondant aux informations recherchées. 

L’utilisateur peut alors cliquer sur n’importe quelle entrée puis sur Submit (Soumettre) pour 
remplir automatiquement l’éditeur d’informations sur l’imagerie avec les informations du patient. 

REMARQUE : l’utilisateur peut également double-cliquer sur n’importe quelle entrée du tableau 
pour accéder rapidement à l’éditeur d’informations sur l’imagerie sans avoir à appuyer sur 
Submit (Soumettre). 

L’éditeur d’informations sur l’imagerie (boîte de dialogue d’informations sur le patient) s’ouvrira. 
Voir Figure 6.3.3. Remplissez les autres champs obligatoires et cliquez sur Accept (Accepter) 
pour procéder à l’acquisition des images. 

 6.3.1 
Sélectionner dans 
la liste de travail 
 
 
 
 
Figure 6.3.2 
Boîte de dialogue Rechercher la 
liste de travail de la modalité 

REMARQUE : toutes les données  
du patient sont fictives. Toute 
ressemblance avec des personnes 
réelles est strictement fortuite. 
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Remarque :  les champs obligatoires sont 

indiqués par un astérisque blanc 
(*). Les champs obligatoires par 
défaut sont : Patient Name (Nom 
du patient), Patient ID (ID du 
patient), Accession Number 
(Numéro d’ordre) et Laterality 
(Latéralité). 

 
L’utilisateur doit compléter tous les champs 
requis avant de pouvoir sélectionner le bouton 
Accept (Accepter). L’utilisateur peut également 
saisir la date, le médecin traitant, le nom de la 
procédure, le sexe, le technicien, la vue de la 
position, la partie du corps et l’ID de l’étude si 
nécessaire. Le nom de la procédure, la vue de 
la position et la partie du corps sont choisis via 
un menu déroulant. 
 
Remarque :  la date doit être inscrite dans le 

format : aaaa/mm/jj (par 
exemple, 1962/08/13). La non-
saisie d’une date valide peut 
entraîner des erreurs lors de la 
récupération des images.  

 
Remarque :  les « champs obligatoires » 

peuvent être modifiés ou 
supprimés selon l’application.  
Contactez l’assistance Hologic 
pour plus d’informations 

 
Sélectionnez Accept (Accepter) pour continuer 
ou Start a New Patient or Procedure 
(Démarrer un nouveau patient ou une nouvelle 
procédure) pour revenir à la page de saisie des 
données du patient. 

 6.3.1 Suite 
 
Figure 6.3.3 
Éditeur d’informations sur 
l’imagerie 
 

 
 
 

 Continuer avec le patient actuel 
 
Cliquez sur ce bouton pour continuer la procédure du patient actuel. L’« Éditeur 
d’informations sur l’image » s’ouvrira. Voir Figure 6.3.3. Suivez la procédure et les remarques 
ci-dessus. 
 
 

 6.3.2 
Continuer avec le 
patient actuel 

 
 
 

Saisie manuelle 
 
Cliquez sur ce bouton pour saisir manuellement une nouvelle procédure. L’« Éditeur 
d’informations sur l’imagerie » s’ouvrira. Voir Figure 6.3.3. Suivez la procédure et les remarques 
ci-dessus. 
 

 6.3.3 
Saisie manuelle 
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Sélectionner dans la base de données 
 
 
En choisissant le bouton Select from Database (Sélectionner dans la base de données), la 
page suivante s’affiche. Voir Figure 6.3.4 ci-dessous. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
L’utilisateur sélectionne un patient dans le tableau situé sur le côté droit de la page et clique 
ensuite sur le bouton Accept (Accepter) qui ouvre l’éditeur d’informations sur l’image. 
(Remarque : l’utilisateur peut également double-cliquer sur l’entrée dans le tableau pour 
ouvrir l’éditeur d’informations sur l’image) Suivez ensuite la procédure et les remarques des 
pages 6 et 7. 

Remarque : utilisez la barre de défilement en bas de l’écran pour afficher les informations 
cachées sur le patient. 

Vision permet à l’utilisateur de réduire la liste des patients en saisissant des informations 
spécifiques dans la fenêtre « Search Parameters » (Paramètres de recherche) sur le côté 
gauche de la page. Seuls les patients correspondant à tous les paramètres de recherche 
s’afficheront.  

 

 6.3.4 
Sélectionner dans 
la base de données 
 
 
Figure 6.3.4 
Sélection du patient à partir des 
entrées de la base de données 
locale 

 
 

REMARQUE : toutes les données du 
patient sont fictives. Toute ressemblance 
avec des personnes réelles est strictement 
fortuite. 
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Si l’utilisateur souhaite modifier ou consulter les informations après leur saisie, 
mais avant qu’une image ne soit prise, il peut cliquer sur l’icône Patient Data 
(Données du patient) dans le coin supérieur gauche de l’écran. Voir Figure 6.3.5. 

 

La fenêtre d’édition des informations sur le patient/l’imagerie s’ouvre. Cette fenêtre d’édition 
sera complétée avec toutes les informations précédemment saisies/sélectionnées. Voir 
Figure 6.3.6. Remarque : la fenêtre d’édition comprendra désormais un bouton Cancel 
(Annuler). 
 
L’utilisateur peut modifier ou ajouter des 
informations à sa guise, puis cliquer sur : 

• Le bouton Accept (Accepter) pour 
enregistrer les modifications et continuer 
l’acquisition d’images. 

• Le bouton Cancel (Annuler) pour annuler  
les modifications et continuer l’acquisition 
d’images. Le logiciel reviendra aux 
informations initiales saisies sur le patient, ou 

• Le bouton Start a New Patient or 
Procedure (Démarrer un nouveau patient 
ou une nouvelle procédure) qui renvoie 
l’utilisateur à l’écran de saisie des données 
du patient. Voir Figure 6.3.1.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Une fois que l’utilisateur a cliqué sur le bouton Accept (Accepter), le système est prêt pour 
l’acquisition d’images/de radiographies. 

Les rayons X sont générés en appuyant sur le bouton vert Start (Démarrer) situé à l’avant de 
l’armoire Faxitron Core ou en cliquant sur le bouton Start X-Ray (Démarrer les rayons X) dans 
le coin inférieur droit de l’écran. Voir la Section 5.2.2, Démarrage de l’exposition. Le système 
prendra une courte radiographie « échantillon », ou pré-photo (explications à la Section 6.4.4) 
suivie d’une exposition plus longue pour acquérir l’image. Le logiciel traitera l’image avant 
qu’elle ne soit affichée sur l’écran du moniteur. Une fois l’image affichée, les boutons situés à 
gauche et à droite de l’écran, couverts tout au long de cette section, seront activés.  

 6.3.5 
Icône de données 
du patient 
Figure 6.3.5 
Icône de données du patient 
 
 
 
 
Figure 6.3.6 
Éditeur d’informations sur l’imagerie 
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L’utilisateur peut consulter, mais non modifier, les 
informations sur le patient après avoir acquis une 
image en cliquant sur l’icône Patient Data (Données 
du patient) de la Figure 6.3.5. Une boîte de dialogue 
modifiée d’informations sur le patient apparaîtra 
alors, comme le montre la Figure 6.3.7. Cette boîte 
comporte deux boutons : Close Dialog (Fermer la 
boîte de dialogue) ou Start a New Patient or 
Procedure (Démarrer un nouveau patient ou une 
nouvelle procédure). L’utilisateur peut consulter, 
mais non modifier, les informations sur le patient 
après avoir acquis une image en cliquant sur l’icône 
Patient Data (Données du patient) de la 
Figure 6.3.4. Une boîte de dialogue modifiée 
d’informations sur le patient apparaîtra alors, 
comme le montre la Figure 6.3.7. Cette boîte 
comporte deux boutons : « Close Dialog » (Fermer 
la boîte de dialogue) ou « Start a New Patient or 
Procedure » (Démarrer un nouveau patient ou une 
nouvelle procédure).  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Une fois qu’une image est prise, 
les propriétés de l’image 
actuelle peuvent être 
visualisées en appuyant sur 
l’icône (i) dans le coin supérieur 
droit. Voir Figure 6.3.8. La boîte 
de dialogue des propriétés de 
l’image s’affiche dans le coin 
supérieur droit de l’image. La 
boîte de dialogue est semi-
transparente, pour permettre de 
voir ce qui se trouve en 
dessous. Voir Figure 6.3.9. 

 
 

 6.3.5 Suite 
 
Figure 6.3.7 
Boîte de dialogue Patient 
Information (Informations sur le 
patient) après l’acquisition d’images 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 6.3.8 
Boîte de dialogue Image Properties 
(Propriétés de l’image) 
 
 
 

Figure 6.3.9 
Propriétés de l’image (visualisation 
uniquement) 
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Le logiciel Vision fournit divers outils et menus pour contrôler divers attributs ou paramètres 
d’image, l’acquisition de rayons X, les vues d’image, les outils d’image et les paramètres/accès 
DICOM. Les outils les plus couramment utilisés se trouvent dans une barre d’outils. La barre 
d’outils et les menus sont décrits plus en détail dans les pages suivantes.  

 
Le logiciel Vision permet d’accéder d’un seul clic à un certain nombre d’outils ou de fonctions 
couramment utilisés grâce à une barre d’outils verticale située sur le côté gauche de l’écran. 
Des descriptions plus détaillées suivent dans les pages suivantes. Voir Figure 6.4.1. 

 

 

Afficher/modifier les informations  
sur le patient 
(Voir Section 6.3.5 et Figure 6.3.5) 
 

Icône Améliorer l’image 
 
 
 

Outil de niveau de la fenêtre et 
de contraste 
 
 
Outil de zoom numérique 
 
 
 
Outils d’annotation 
 
 
 

Enregistrement PACS 
 
 
 
Impression PACS 
 
 
 
Contrôle de l’exposition  
(panneau de commande du dispositif) 
 
 
Retour au menu principal 
 
 
 
Arrêt du système 
 
 

 

 6.4.0 
Barre d’outils et 
menus 
 

6.4.1 
Barre d’outils 
latérale 
 
 

Figure 6.4.1 
Barre d’outils latérale REMARQUES : 

 
Les outils suivants sont toujours 
actifs dans la page d’acquisition 
d’images : 
• Afficher/modifier les informations 

sur le patient. 
• Contrôle de l’exposition. 
• Retour au menu principal, et  
• Arrêt du système. 
 
Les outils suivants seront désactivés 
après la saisie des données du 
patient et ne seront activés qu’après 
l’acquisition d’une image 
radiographique : 
• Améliorer l’image. 
• Niveau de la fenêtre et contraste. 
• Zoom numérique, et 
• Annotation. 
 
Les outils d’enregistrement PACS et 
d’impression PACS ne sont activés 
qu’après l’acquisition d’une image 
radiographique et lorsque le système 
est connecté à un réseau PACS. 
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Améliorer l’image 
 
Le bouton présenté à la Figure 6.4.2 traite l’image sur l’écran pour mettre en valeur les détails 
plus petits, tels que les micro-calcifications et les petites masses dans l’image.  
 
 
 

L’algorithme, communément appelé « Peripheral Equalization » (Égalisation périphérique) ou 
« Thickness Equalization » (Égalisation d’épaisseur) en imagerie avancée, est appliqué à 
l’ensemble de l’image.  En plus de cet algorithme, Hologic utilise un deuxième algorithme 
développé en interne appelé « Calcification Emphasis » (Accentuation de la calcification). Cet 
algorithme secondaire a été conçu pour faire ressortir les petits détails de l’image et les rendre 
beaucoup plus faciles à voir et à analyser.  
 
Comme les images des patients constituent une catégorie plus générale pour les géométries 
et les différentes épaisseurs possibles, certains échantillons peuvent avoir des géométries 
délicates et l’utilisateur doit utiliser cet outil avec précaution.  
 
Le système sera inactif (en veille) pendant le traitement et une fois le traitement terminé, le 
bouton restera enfoncé/actif. L’utilisateur peut annuler le processus en appuyant à nouveau 
sur le bouton. 
 

 6.4.1 Suite 
 
 
Figure 6.4.2  
Icône d’amélioration de l’image  
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Réglage de l’inversion, du niveau de la fenêtre et du contraste 
 
Le bouton, illustré à la Figure 6.4.3, ouvre l’outil de réglage du niveau de la fenêtre et du 
contraste. Cet outil permet à l’utilisateur d’ajuster le niveau de la fenêtre et le contraste de 
l’image. L’utilisateur peut également restaurer le contraste d’origine en appuyant sur le bouton 
Original Contrast (Contraste d’origine), ou inverser l’image, en appuyant sur le bouton Invert 
(Inverser). L’inversion fait passer le schéma de couleurs d’une prédominance de noir à une 
prédominance de blanc, ou inversement. Voir Figure 6.4.4 ci-dessous. 
 
 
 
 
 
 
 
 
 
 
 
 
L’utilisateur peut également régler le curseur pour le contraste 
d’image souhaité en cliquant sur la barre et en le déplaçant 
vers le haut et vers le bas ou en cliquant sur l’une des flèches 
indicatrices sur la barre pour déplacer les limites inférieures 
ou supérieures du niveau de la fenêtre. Voir Figure 6.4.3 
(officieusement, ceci est également connu sous le nom de 
« Window Leveling » [Mise à niveau de la fenêtre]). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Un exemple d’inversion est présenté ci-dessous : 
 

 6.4.1 Suite 
 
 
 
 
 

Figure 6.4.3 
Icône et commandes de l’outil de 
niveau de la fenêtre et de 
contraste 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figures 6.4.4 
Exemple d’inversion avec 
l’outil de niveau de la fenêtre et 
de contraste 
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Réglage dynamique du zoom 
 
L’icône de l’outil de zoom, Figure 6.4.5, ouvrira l’outil de réglage du zoom. Après avoir ouvert 
cet outil, l’utilisateur peut utiliser la barre de défilement pour ajuster le niveau de zoom ou cliquer 
sur les boutons Fit to Specimen (Ajuster à l’échantillon), Fit to screen (Ajuster à l’écran) ou 
Zoom 1.0x (Zoom x1,0) (pleine résolution). Voir Figure 6.4.6. Lorsqu’un zoom a été effectué 
sur l’image, un panoramique est nécessaire pour naviguer dans l’image. Une boîte de dialogue 
sous forme de vignettes apparaîtra dans le coin supérieur gauche de l’écran. Voir Figure 6.4.7 
ci-dessous. Cliquez sur le bouton gauche sur l’image et maintenez-le enfoncé, puis déplacez la 
souris pour déplacer l’image dans l’écran principal. 
 
Notez que traditionnellement, cette fonction est aussi appelée « Pan View » (Panoramique) 
et/ou « Pan and Scan » (Panoramique et balayage). 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
Le bouton Fit to Specimen (Ajuster à l’échantillon) tente de détecter et 
de zoomer sur l’échantillon afin de s’assurer qu’il est entièrement visible. 
Si aucun échantillon n’est détecté, il reviendra par défaut au mode 
précédent (soit « Fit to Screen » [Ajuster à l’écran] ou « Zoom 1.0x » 
[Zoom x1,0]). 
 
L’option Fit to screen (Ajuster à l’écran) ajuste l’image à l’écran. 
 
Le Zoom 1.0x (Zoom x1,0) est traditionnellement appelé « Full 
Resolution » (Pleine résolution) car il offre une vue de l’image à la taille 
1-1 avec la résolution du moniteur. 
 
 
 

Annotations 
 
Le bouton présenté à la Figure 6.4.8 ouvre les outils d’annotation. Ces outils et leurs 
nombreuses options sont présentés plus en détail à la Section 6.8.0. 
 

 6.4.1 Suite 
 
 
 
 
 
 
 
 
 
 
 

Figure 6.4.5 
Icône d’outil de zoom 
 
 

Figure 6.4.6 
Outil de réglage du niveau de 
zoom 
 
 
 
Figure 6.4.7 
Exemple de vue panoramique (à 
gauche) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 6.4.8  
Icône d’annotations 
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Enregistrement PACS 

Le bouton présenté à la Figure 6.4.9 fonctionne uniquement lorsque le système est 
installé dans un établissement médical doté d’un réseau PACS. Pour enregistrer 
vos fichiers localement, reportez-vous à la Section 6.7.0. 
 
 

Impression PACS 

Le bouton présenté à la Figure 6.4.10 fonctionne uniquement lorsque le système est 
installé dans un établissement médical doté d’un réseau PACS. Pour une impression 
locale, reportez-vous à la Section 6.7.0. 
 
 

Panneau de commande du dispositif 
Le bouton présenté à la Figure 6.4.11 ouvre le panneau de commande du dispositif, 
qui permet à l’utilisateur du dispositif de commander facilement le système de 
radiographie par le biais du logiciel. L’utilisateur peut facilement sélectionner le mode 
d’exposition, le réglage des kV du tube à rayons X, le temps d’exposition et le 
nombre d’images à acquérir pour le calcul de la moyenne des images (si désiré) ainsi que lancer 
l’exposition aux rayons X. 
 
 
REMARQUE : l’état ou la disponibilité des paramètres 
d’exposition est indiqué par les flèches haut/bas 
adjacentes au paramètre. Les flèches seront blanches 
pour les paramètres actifs et bleu clair pour les 
paramètres inactifs. Les paramètres d’exposition qui 
sont actifs dépendent du mode d’exposition 
sélectionné. 
 
La Figure 6.4.12 à droite montre que le mode 
entièrement manuel a été sélectionné et que les 
moyennes kV, temps et image sont toutes actives. 
L’utilisateur peut ajuster chacun de ces paramètres.  
 
 
 
 
 
 
Notez que le paramètre mA dans le système Faxitron 
Core n’est pas réglable par le logiciel et qu’il sera 
toujours inactif. 
 
 
 
 
 
 
Lorsque vous avez terminé, cliquez sur le bouton 
Request X-Rays (Demande de rayons X) pour acquérir 
une image, ou sur le bouton Set (Régler) pour 
enregistrer les paramètres et fermer le panneau de 
commande du dispositif. 
 
Si vous cliquez sur le bouton Cancel (Annuler), le panneau de commande du dispositif se 
fermera sans enregistrer les modifications. 

 6.4.1 Suite  
 
Figure 6.4.9  
Icône d’enregistrement PACS  
 
 
 
Figure 6.4.10  
Icône d’impression PACS  
 
 
 
 
Figure 6.4.11 
Icône du panneau de commande 
du dispositif 
 
 
 
 
Figure 6.4.12 
Panneau de commande du 
dispositif 
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Retour à la procédure 

Le bouton présenté à la Figure 6.4.13 permet de quitter le mode d’acquisition 
d’images et de revenir à l’écran du menu d’accueil. 

 

Arrêt 
Le bouton, illustré à la Figure 6.4.14, permet de quitter le logiciel et d’éteindre 
l’ordinateur. 

 

 

Remarques supplémentaires concernant les boîtes de dialogue 
Lorsqu’une boîte de dialogue est ouverte, elle est « ancrée » à gauche de l’écran. Si un 
utilisateur souhaite désolidariser la boîte de dialogue, il peut cliquer sur l’icône « Épingle » en 
haut à droite pour désolidariser la boîte de dialogue et pouvoir la faire glisser librement. 
L’épingle se transforme alors en icône « X » permettant une fermeture rapide. 

L’utilisateur peut également naviguer rapidement entre les différentes boîtes de dialogue en 
cliquant sur le menu de gauche. Ce faisant, le menu de gauche se ferme rapidement et ouvre 
les boîtes de dialogue appropriées. 
 

 
Barre de menu supérieure 

Le logiciel permet d’accéder aux menus « View » (Affichage), « Tools » (Outils), « Image 
Tools » (Outils image), « DICOM Utilities » (Utilitaires DICOM) et « Help » (Aide) via une barre 
de menu supérieure. Voir Figure 6.4.15. La barre de menu supérieure est masquée par défaut 
et s’affiche en cliquant sur le bouton Flèche dans le coin supérieur droit de l’écran. Voir 
Figure 6.4.16. Le bouton Flèche est noir ou blanc selon la page du logiciel ou le fond d’écran. 
Chaque élément du menu est traité en détail dans les pages suivantes. 

 
 

Remarque : la flèche pointe vers le bas lorsque la barre de menu 
supérieure est masquée et pointe vers le haut lorsqu’elle est affichée. 
 

 
Menu View (Affichage) 

Le menu « View » (Affichage) est situé dans le menu principal supérieur et contient les éléments 
de sous-menu indiqués dans la Figure 6.4.17 ci-dessous. Chacune de ces options sera décrite 
plus en détail dans les pages suivantes. 
 
 
 
 
 
 
 
 
 
 

 6.4.1 Suite  
 
Figure 6.4.13  
Icône de retour au menu d’accueil 
 
 
 

Figure 6.4.14 
Icône d’arrêt du système 
 
 
 
 
 
 
 
 
 
 
 

6.4.2 
Barre de menu 
supérieure 
 
 
 
 
 
Figure 6.4.15  
Barre de menu supérieure 

Figure 6.4.16  
Boutons de la barre de menu 
supérieure 
 
 

6.4.3 
Affichage 
 

Figure 6.4.17  
Menu View (Affichage) 
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Zoom Mode (Mode Zoom) 
 

Normal (Normal) 
Affiche l’image acquise dans son format d’origine. Le format d’origine de l’image du Faxitron 
Core s’adapte à la zone d’affichage du moniteur. L’utilisateur peut zoomer sur l’image s’il le 
souhaite. Reportez-vous au réglage dynamique du zoom à la Section 6.4.1.  
 

Adjust Zoom (Régler le zoom) 
Cette option est grisée et n’est pas disponible pour le moment. 
 

Fit to Sample (Ajuster à l’échantillon) 
Cette option permet d’ajuster l’image acquise pour qu’elle corresponde au mieux à l’échantillon 
dans la zone d’affichage du moniteur. 

 
Fit All (Ajuster tout) 

Cette option affiche l’ensemble de l’image acquise, quel que soit son format d’origine. L’option 
Full Resolution (Pleine résolution) ne fonctionne pas dans ce mode d’affichage.  
 

Fit Width (Ajuster la largeur) 
Cette option permet d’afficher l’image acquise sur toute la largeur disponible de la zone 
d’affichage. 
 

Fit Height (Ajuster la hauteur) 
Cette option permet d’afficher l’image acquise sur toute la hauteur disponible de la zone 
d’affichage.  
 

Image Averages (Moyennes des images) 
Cette option permet à l’utilisateur de régler le nombre de moyennes d’images à prendre par 
exposition. Les options disponibles sont les suivantes : prises de vue x1, x2, x4 ou x8. Le 
réglage par défaut est le suivant : prises de vue x1. Si l’utilisateur sélectionne 2, 4 ou 8 prises 
de vue, le logiciel acquiert le nombre d’images sélectionnées dos à dos par une simple pression 
sur le bouton Start (Démarrer) et fait la moyenne de ces images en une seule. 
 

Image Perspective (Perspective d’image) 
Cette option permet à l’utilisateur de faire pivoter l’image affichée de 0, 90, 180 et 270 degrés 
pour l’orienter. 
 

 6.4.3 Suite 
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Grid Options (Options de grille) 
Lorsqu’une image est affichée, que ce soit une image acquise ou une image récupérée dans 
la base de données, l’utilisateur peut activer une grille. Elle permet également à l’utilisateur de 
régler l’espacement de la grille (pas). Voir l’exemple ci-dessous. 
 

 
User Window Levels  

(Niveaux de la fenêtre utilisateur) 
Ceci permet à l’utilisateur de définir jusqu’à trois (3) niveaux de fenêtre (WL) prédéfinis et définis 
par l’utilisateur. Sélectionnez d’abord le bouton Window Level (Niveau de la fenêtre) et ajustez 
le WL au niveau souhaité. Dans le menu « View » (Affichage), sélectionnez « User Window 
Levels » (Niveaux de fenêtre utilisateur). Sélectionnez « Record Current WL » (Enregistrer le 
WL actuel) en tant que WL UTILISATEUR N°1, N°2 ou N°3. Le WL réglé sera enregistré sous 
le choix précédemment sélectionné. 

Default Window Level  
(Niveau de fenêtre par défaut) 

L’utilisateur a le choix entre deux niveaux « Default Window Levels [WL] » (Niveaux de fenêtre 
[WL] par défaut). Optimize for whole area (Optimiser la zone entière), qui ajuste le WL pour 
l’image entière, ou « Optimize for sample » (Optimiser pour l’échantillon), qui ajuste le WL pour 
la zone sous l’échantillon uniquement. De plus, il existe une option permettant de « Set Default 
Window Level » (Définir le niveau de fenêtre par défaut), utilisée pour toutes les images 
obtenues, situées ici également. Ceci définira le niveau de fenêtre par défaut basé sur les 
statistiques de l’image ; cette action devra être effectuée séparément pour les images non 
améliorées et améliorées. 

Default Aspect of Raw Files  
(Aspect par défaut des fichiers bruts) 

Il permet d’importer/ouvrir des fichiers d’images précédemment enregistrés avec des attributs 
de fichiers inconnus ou des données d’images binaires sans aucune information d’en-tête. 
Comme la taille exacte du tableau de l’imageur n’est pas disponible dans l’en-tête du fichier de 
données d’image, on utilisera les dimensions de l’imageur les plus proches pour importer/ouvrir 
ces images, en se basant sur le fait que la largeur est supérieure ou inférieure à la hauteur 
(informations d’aspect par défaut). 

 6.4.3 Suite 
 
 
 

Figure 6.4.18 
Affichage de la grille 
d’échantillonnage 
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Enhance Image (Améliorer l’image),  
identique au bouton du même nom 

Traite l’image actuelle du patient et améliore la visualisation des tissus situés près de la 
périphérie de l’échantillon. 

Sample Viewer (Affichage d’échantillon) 
Sample View (Affichage d’échantillon) active l’affichage webcam afin de faciliter l’alignement 
des échantillons. Aucune webcam ne peut être ajoutée au système Faxitron Core. 

Magnifier Size (Taille de la loupe) 
Permet à l’utilisateur de sélectionner la taille de l’outil Loupe (voir le menu Outils image). Les 
options sont « Small » (Petite), « Medium » (Moyenne) et « Large » (Grande).  

Review Layout (Mise en page de la révision) 
Aide l’utilisateur à conFigurer plusieurs volets d’image en mode Review (Révision) (base de 
données) du programme. Les options disponibles sont les suivantes ; mise en page « (1 X 1) 
Single » (Simple [1 X 1]), « (2 X 1) Double H » (Double H [2 X 1]), « (1 X 2) Double V » (Double 
V [1 X 2]), « (1 + (2 X 1) Triple » (Triple [1 + (2 X 1)]) et « (2 X 2) Quadruple » (Quadruple 
[2 X 2]). Pendant les opérations sur plusieurs volets, l’utilisateur peut cliquer une fois sur le 
volet/image désiré(e) pour en faire la sélection courante ; la bordure rectangulaire du volet 
sélectionné deviendra verte. Les images dans la vue Liste de base de données ou dans la vue 
Vignettes de la base de données seront ouvertes dans le panneau sélectionné à l’aide d’un 
double-clic. L’utilisateur peut également ouvrir les images dans les volets souhaités directement 
à partir du menu contextuel (clic droit) des vues de la base de données mentionnées. Après 
avoir activé le menu contextuel à l’aide d’un clic droit, l’utilisateur peut choisir parmi les volets 
listés sous OPEN TO→ (OUVRIR DANS) qui lui fourniront les volets disponibles pour ouvrir 
l’image (gauche, droite, haut, bas, etc.). 

 
 

Menu Tools (Outils) 
Le menu « Tools » (Outils) est situé dans la barre de menu supérieure qui se trouve dans le 
coin supérieur gauche de l’écran principal. 

 
 

Preferences (Préférences) 
Le menu « Preferences » (Préférences) ouvre un utilitaire de gestion de la configuration qui 
peut être utilisé pour modifier diverses options ou paramètres.  

REMARQUE : l’option de l’outil « Preferences » (Préférences) est protégée par mot de passe 
et ne doit être accessible qu’à un représentant de service Hologic autorisé. 

 6.4.3 Suite 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
6.4.4 
Menu Outils 
 
 
Figure 6.4.19  
Menu Tools (Outils) 
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REMARQUE : la modification des paramètres de configuration sans connaissance ou 
autorisation appropriée peut entraîner une perte de qualité d’image, des dommages au système 
et un dysfonctionnement de ce dernier. 

Service Mode (Mode entretien) 
Le « Service Mode » (Mode entretien) est protégé par mot de passe et est activé par les 
techniciens autorisés de Hologic à des fins de dépannage.   

Service Tools (Outils d’entretien) 
L’option « Service Tools » (Outils d’entretien) est normalement grisée. Elle n’est activée que 
lorsque le système est en « Service Mode » (Mode entretien). 

Save Reference Files (Enregistrer les fichiers de référence) 
L’option « Save Reference Files » (Enregistrer les fichiers de référence) est normalement 
grisée. Elle n’est activée que lorsque le système est en « Service Mode » (Mode entretien). 

 
Options du menu Advanced Tools (Outils avancés) 

Le menu « Advanced Tools » (Outils avancés) propose diverses options pour configurer des 
aspects du logiciel tels que le post-traitement et les options de configuration. 
 

Auto Save On/Off (Enregistrement automatique Marche/Arrêt) 
Lorsque l’option « Auto Save » (Enregistrement automatique) est activée, toutes les images 
acquises ultérieurement sont enregistrées dans la base de données. Les fichiers sont 
enregistrés dans la base de données du répertoire de données défini dans le fichier de 
configuration. 
 

X-Ray Calibration/Exposure Set-up (Étalonnage des rayons 
X/Configuration de l’exposition) 

Cet outil se trouve dans Advanced tools (Outils avancés). L’option « X-Ray 
Calibration/Exposure Set-up » (Étalonnage des rayons X/Configuration de l’exposition) aide 
l’utilisateur à déterminer le temps d’exposition approprié pour un réglage kV sélectionné afin 
d’obtenir une meilleure qualité d’image. Veuillez vous reporter à la Section 6.2.0 et à la 
Figure 6.2.4 pour une description plus détaillée. 
 

Preshot AEC Exposure Setup  
(Configuration de la pré-photo de l’exposition de l’AEC) 

Le système Faxitron Core utilise le contrôle automatique de l’exposition (AEC) pour fournir la 
meilleure qualité d’image possible par une simple pression sur le bouton « Start X-Ray » 
(Démarrer les rayons X). Le logiciel utilise une exposition Preshot (Pré-photo) pour calculer 
l’exposition optimale en kV et les paramètres de temps. La Preshot (Pré-photo) est une 
exposition courte, généralement de 2 à 3 secondes, aux rayons X. Le logiciel analyse les 
résultats pour déterminer le kV et le temps nécessaires pour produire la meilleure qualité 
d’image. La pré-photo de l’exposition de l’AEC est configurée à l’usine et est activée par défaut.  

« Preshot AEC Exposure Setup » (Configuration de la pré-photo de l’exposition de l’AEC) 
permet à l’utilisateur d’ajuster le système pour des besoins d’imagerie particuliers ou pour 
compenser le vieillissement du système. 
Pour accéder à la boîte de dialogue « Preshot AEC Exposure Setup » (Configuration de la pré-
photo de l’exposition de l’AEC), allez dans la barre de menu supérieure, sélectionnez « Tools » 
(Outils), « Advanced Tools » (Outils avancés) puis « PRESHOT AEC Exposure Setup » 
(Configuration de la PRÉ-PHOTO de l’exposition de l’AEC). Voir Figure 6.4.19. La boîte de 
dialogue des paramètres de pré-photo de l’AEC illustrée à la Figure 6.4.20 s’ouvrira. 

 6.4.4 Suite 
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Saisissez les valeurs d’AEC pour la PRÉ-PHOTO dans la fenêtre de droite. 

Les paramètres indiqués 
reflètent un temps d’exposition 
de 23 kV et de 2 secondes 
avec une intensité cible de 
8000 ADU pour le paramètre 
de pré-photo. Les utilisateurs 
ne peuvent entrer les 
paramètres de pré-photo que 
lorsque la DYNAMIC METHOD 
(MÉTHODE DYNAMIQUE) 
(dans la section PRESHOT 
ANALYSYS METHOD 
[MÉTHODE D’ANALYSE DE 
PRÉ-PHOTO]) est 
sélectionnée. La sélection de 
STATIC METHOD 
(MÉTHODE STATIQUE) utilise 
les paramètres prédéfinis par 
Hologic. De plus, l’utilisateur a 
la possibilité de sélectionner 
les réglages de kV et de temps 
d’exposition dans la section 
EXPOSURE TUNING 
METHOD (MÉTHODE DE 
SYNTONISATION DE 
L’EXPOSITION). 

Pour des images plus précises, 
l’utilisateur peut saisir 
l’épaisseur du TISSU MOU 
(échantillon) et l’INTENSITÉ 
CIBLE dans les ADU.  

Remarque : les valeurs 
indiquées se situent dans la fourchette typique d’un système Faxitron Core, mais peuvent varier. 

Pour le mode AUTOMATIC EXPOSURE CONTROL (COMMANDE D’EXPOSITION 
AUTOMATIQUE), appuyez sur le bouton Start (Démarrer) du logiciel Vision (ou sur le panneau 
de commande). Le logiciel Vision effectue une pré-photo (courte, à faible dose, pré-exposition) 
de l’échantillon pour créer une région d’intérêt (ROI) afin d’obtenir les paramètres d’exposition 
permettant d’obtenir une exposition optimale de l’image. 

Utilitaire de connexion 
L’utilitaire de connexion se trouve dans le menu « Advanced Tools » (Outil avancés) et permet 
à l’utilisateur de configurer et d’activer l’authentification par mot de passe de démarrage pour 
le logiciel Vision. L’activation de cette 
fonction est facultative sur le système 
Faxitron Core. Si l’utilisateur active 
l’authentification par mot de passe, il 
sera invité à saisir le mot de passe à 
chaque ouverture du programme. Le 
programme se fermera si le mot de 
passe correct n’est pas saisi. 

 

 

 

 

 6.4.4 Suite 
 
Figure 6.4.20 
Preshot AEC Exposure Setup 
(Configuration de la pré-photo de 
l’exposition de l’AEC)  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 6.4.21 
Utilitaire de connexion 
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Properties (Propriétés) 
L’option « Properties » (Propriétés) masque ou affiche la boîte d’informations sur l’image. Voir 
Figure 6.3.9. 

Edit Current Image Record (Modifier le dossier d’image actuelle) 
Actuellement non utilisé. 

Delete Current Image Record  
(Supprimer le dossier d’image actuelle) 

Supprime l’image actuelle du répertoire de fichiers comme spécifié dans le fichier de 
configuration. 

Add Current Image Record (Ajouter un dossier d’image actuelle) 
Ajoute l’image actuelle au répertoire de fichiers comme spécifié dans le fichier de configuration. 

Capture Screen Shot JPG/BMP (Capture d’écran JPG/BMP) 
En sélectionnant ce choix dans le menu, l’utilisateur peut faire une capture d’écran de la fenêtre 
active affichée. L’utilisateur peut spécifier un nom de fichier et choisir entre les formats JPG et 
BMP pour enregistrer le fichier. 

Save / Store Current Image (Enregistrer/Stocker l’image actuelle) 
L’utilisateur peut « naviguer » vers le répertoire ou le dossier de fichiers dans lequel l’image 
doit être enregistrée. Un nom de fichier doit être attribué dans le champ prévu à cet effet. 
L’utilisateur peut enregistrer l’image sous forme de fichier de type BMP, JPEG, TIF, RAW Data 
ou DICOM. Pour enregistrer le fichier dans un format DICOM, reportez-vous à la section 
« Fonctionnalité DICOM ». 

Print Current Image (Imprimer l’image actuelle) 
Imprime l’image actuelle sur l’imprimante Windows. 

 

Image Tools (Outils image) 
Les fonctions suivantes sont disponibles pour modifier l’image acquise ou récupérée en cliquant 
sur le menu « Image Tools » (Outils image). Voir Figure 6.4.22. Les options du sous-menu sont 
activées ou accessibles par un simple clic de souris sur l’option souhaitée. 

 

 

 
 

6.4.4 Suite 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
6.4.5 
Outils image 
 
 
Figure 6.4.22 
Menu Image Tools (Outils image) 
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Original Contrast (Contraste d’origine) 
L’option « Original Contrast » (Contraste d’origine) rétablit les niveaux de contraste de l’image. 
Elle a le même objectif que le bouton Original Contrast (Contraste d’origine) dans l’outil de 
niveau de la fenêtre et de contraste. Voir Section 6.4.1 et Figure 6.4.3. 

Invert (Inverser) 
L’option « Invert » (Inverser) provoque l’inversion ou le renversement de l’image affichée. 
L’inversion d’une image inverse sa transparence : ce qui est noir devient blanc et ce qui est 
blanc devient noir. Les gris se voient attribuer leur transparence « miroir ». Cliquez à nouveau 
sur « Invert » (Inverser) pour désactiver la fonction. Exécute la même fonction que le bouton 
Invert (Inverser). Reportez-vous à la Section 6.4.1 et aux Figures 6.4.3 et 6.4.4. 

Magnify (Agrandir) 
L’option « Magnify » (Agrandir) permet à l’utilisateur d’agrandir une zone d’intérêt. Pour utiliser 
la fonction Magnify (Agrandir), placez le curseur de la souris sur la zone à agrandir et faites un 
clic gauche. La zone d’intérêt sera agrandie. Cliquez à nouveau sur « Magnify » (Agrandir) pour 
désactiver la fonction. Reportez-vous à la Figure 6.4.23. La taille de la zone d’intérêt agrandie 
peut être ajustée par l’utilisateur. Reportez-vous au sous-menu « Magnifier Size » (Taille de la 
loupe) de la Section 6.4.3.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Edge Enhance (Amélioration des contours) 
L’option « Edge Enhance » (Amélioration des contours) crée une définition plus nette autour 
des contours des régions présentant une différence de contraste. D’une manière générale, 
l’amélioration des contours peut amplifier le bruit des images. En sélectionnant à nouveau cet 
élément dans le menu, vous désactivez l’amélioration des contours. Cliquer sur « Original 
Contrast » (Contraste d’origine) permet également de rétablir l’image dans son état d’origine. 
Notez qu’il s’agit d’une fonction différente de l’option Enhance Image (Améliorer l’image) décrite 
aux Sections 6.4.1 et 6.4.3. 

ROI Contrast (Contraste de la ROI) 
L’option « ROI Contrast » (Contraste de la ROI) permet d’optimiser les niveaux de contraste 
dans une région d’intérêt (ROI) définie par l’utilisateur. Après avoir sélectionné « ROI Contrast » 
(Contraste de la ROI), cliquez et maintenez le bouton gauche de la souris au point de départ 
de la ROI désirée, faites glisser la souris et relâchez le bouton de la souris au point final de la 
ROI désirée. Le contraste se règle automatiquement sur les meilleurs niveaux pour cette ROI. 

ROI Window Level (Niveau de fenêtre de la ROI) 
La fonction « ROI Window Level » (Niveau de fenêtre de la ROI) n’est pas disponible dans la 
version actuelle du logiciel Vision. 

 6.4.5 Suite 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 6.4.23 
Magnify (Agrandir) 
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Ruler (Règle) 
L’option « Ruler » (Règle) permet à l’utilisateur de mesurer la distance entre deux points de 
l’image affichée. Les mesures de longueur sont en millimètres (mm). Après avoir sélectionné 
« Ruler » (Règle), cliquez et maintenez le bouton gauche de la souris enfoncé en commençant 
par le point de mesure, faites glisser la souris et relâchez le bouton de la souris au point de 
mesure final. La règle est affichée sous la forme d’une ligne rouge sur l’image. 
 
La mesure (en mm) s’affiche à 
l’extrémité de la règle. La règle 
reste active jusqu’à ce que 
l’utilisateur sélectionne un autre 
outil d’image ou jusqu’à ce qu’une 
autre action soit effectuée. Voir 
Figure 6.4.24. Cliquez à nouveau 
sur « Ruler » (Règle) pour 
désactiver la fonction. 
 
Astuce : pour obtenir une ligne 
parfaitement horizontale, verticale 
ou une règle de 45 degrés, 
maintenez la touche SHIFT 
enfoncée (sur le clavier) tout en 
maintenant le bouton gauche de la 
souris enfoncé en la faisant 
glisser. 
 
 

ROI Statistics (Statistiques de la ROI) 
« ROI Statistics » (Statistiques de la ROI) affichera une boîte de dialogue contenant des 
statistiques sur les images. Cliquez et maintenez le bouton gauche de la souris enfoncé sur la 
région d’intérêt (ROI) de l’image principale, faites glisser le curseur pour faire une sélection 
autour de la zone, puis relâchez le bouton de la souris. Les informations statistiques pour la 
région sélectionnée s’afficheront sur le côté gauche de la boîte de dialogue et pour l’image 
entière sur le côté droit de la boîte. Les statistiques affichées sont les suivantes : les points de 
début et de fin de la ROI, les valeurs d’intensité minimale, maximale et moyenne, et l’écart type 
(STD). Pour fermer la boîte d’information Statistics (Statistiques), il suffit de cliquer sur le bouton 
Close (Fermer). Voir Figure 6.4.25. Cliquez à nouveau sur « ROI Statistics » (Statistiques de 
la ROI) pour désactiver la fonction. 

 
 

 6.4.5 Suite 
 
 
 
 
 

Figure 6.4.24 
Ruler (Règle) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 6.4.25 
ROI Statistics (Statistiques de la 
ROI) 
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ROI Histogram (Histogramme de la ROI) 
« ROI Histogram » (Histogramme de la ROI) créera un histogramme pour une ROI définie par 
l’utilisateur. Après avoir sélectionné l’élément du menu, placez le curseur de la souris dans 
l’image affichée, appuyez sur le bouton gauche de la souris et maintenez-le enfoncé, puis faites 
glisser le curseur pour effectuer la sélection de la ROI souhaitée. Relâchez le bouton de la 
souris. Les histogrammes s’affichent pour la ROI sélectionnée. Voir Figure 6.4.26. 

La courbe noire est l’histogramme de la région sélectionnée. La courbe bleue est l’histogramme 
de l’image entière. Les deux courbes sont normalisées par rapport à la valeur maximale du pixel 
de la région d’intérêt sélectionnée. Cliquez à nouveau sur « ROI Histogram » (Histogramme de 
la ROI) pour désactiver la fonction. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 

ROI Profile (Profil de la ROI) 
L’option « ROI Profile » (Profil de la ROI) crée un profil pour une ROI définie par l’utilisateur. 
Après avoir sélectionné l’élément de menu, placez le curseur sur l’image affichée. Maintenez le 
bouton gauche de la souris enfoncé et déplacez le curseur sur l’image pour dessiner un cadre 
défini par l’utilisateur autour de la ROI souhaitée. Relâchez le bouton gauche de la souris et un 
profil s’affichera donnant les valeurs individuelles des pixels de la ROI définie. Voir 
Figure 6.4.27. Par défaut, la direction de moyennage de la ROI sélectionnée est l’axe court. 
L’axe peut être changé en sélectionnant le bouton SWITCH, HOR<->VERT (BASCULER, 
HOR<->VERT). Cliquez à nouveau sur « ROI Profile » (Profil de la ROI) pour désactiver la 
fonction. 

 
 

 

 

 

 6.4.5 Suite 
 
 
 
 
 
 
 
 
 
 
 
Figure 6.4.26 
ROI Histogram (Histogramme de 
la ROI) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 6.4.27 
ROI Profile (Profil de la ROI) 
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Line Profile (Profil de ligne) 

L’option « Line Profile » (Profil de ligne) affichera un profil pour une ligne définie par 
l’utilisateur. Après avoir sélectionné « Line Profile » (Profil de ligne), placez le curseur sur 
l’image affichée. Maintenez le bouton gauche de la souris enfoncé et déplacez le curseur sur 
l’image pour tracer une ligne définie par l’utilisateur. Relâchez le bouton gauche de la souris 
et un profil sera généré, affichant les valeurs individuelles des pixels de la ligne définie. Voir 
Figure 6.4.28. Par défaut, le premier point sélectionné est toujours la partie la plus à gauche 
(près de l’origine) du graphique (c’est-à-dire que l’axe horizontal du graphique peut avoir des 
indices de pixels (i,j) croissants ou décroissants, selon les points de début/fin sélectionnés). 
Cliquez à nouveau sur « Line Profile » (Profil de ligne) pour désactiver la fonction. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Built-In Window Level (Niveau de fenêtre intégré) 
Le logiciel Vision est livré avec une fonction de niveau de fenêtre « intégré ». Il n’y a aucun 
bouton ou élément de menu pour la sélectionner. La fonction « Niveau de fenêtre » est 
automatiquement activée chaque fois qu’une image est acquise ou récupérée de la base de 
données pour révision. Cette fonction permet à l’utilisateur de régler le contraste et la 
luminosité de l’image à l’aide de la souris/du curseur. 

Cliquez et maintenez le bouton gauche de la souris enfoncé sur l’image affichée et déplacez 
le curseur de haut en bas pour les niveaux de luminosité/obscurité. Ou déplacez le curseur 
vers la gauche et la droite pour obtenir un contraste faible/élevé. Déplacez le curseur jusqu’à 
ce que l’image atteigne les niveaux souhaités. 

 

 6.4.5 Suite 
 
 
 
 
 
 
 
 
Figure 6.4.28 
Line Profile (Profil de ligne) 
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En appuyant sur le bouton, illustré à la Figure 6.5.1, situé en bas de la fenêtre d’acquisition 
d’image, la bande des vignettes d’images du patient actuel apparaît. Voir Figure 6.5.2. 
 
 
 
 
 
 
 

 
 

 

La bande des vignettes affiche la date de la procédure pour chaque série d’images 
individuelles en texte orange dans la partie supérieure. 

L’image actuelle affichée dans la fenêtre d’acquisition d’images sera surlignée en vert. 

La bande des vignettes est compatible avec les opérations de glisser-déposer pour placer 
les images dans la zone d’affichage des images ou dans les volets de révision, selon les 
besoins. 

De plus, d’un simple clic, l’utilisateur peut sélectionner plusieurs images puis choisir parmi 
différentes options pour enregistrer les images sur une clé USB, envoyer les images au 
PACS ou supprimer les images. Les images sélectionnées sont mises en surbrillance en 
orange. 

Des flèches s’affichent à gauche et à droite de l’écran. Dans le cas où de nombreuses images 
sont prises, l’utilisateur peut parcourir les images prises, par date croissante, en appuyant 
sur les flèches gauche/droite. 

L’option Open the Database (Ouvrir la base de données) (voir Figure 6.5.3) est aussi 
disponible et fait entrer en mode Review (Révision). Ce bouton équivaut à appuyer sur 
Review Mode (Mode Révision) dans le menu d’accueil. Voir Figures 6.0.1 et 6.6.1. 

 

 

Le mode Révision est accessible en cliquant sur le bouton Review (Révision) dans la page 
du menu d’accueil, Figures 6.6.1 et 6.0.1, ou sur le bouton Open 
Database (Ouvrir la base de données) dans le navigateur d’images 
actuelles. Voir Figure 6.5.3 ci-dessus. En cliquant sur l’un ou l’autre de 
ces boutons, la base de données s’ouvrira comme indiqué dans la 
Figure 6.6.2. Le système sera en veille pendant le mode de révision.  
 
 

 6.5.0 
Navigateur pour 
les images du 
patient actuel 
Figure 6.5.1 
Icône du navigateur pour les 
images du patient actuel 
 
Figure 6.5.2 
Navigateur pour les images du 
patient actuel 
 
 
 
 
 
Figure 6.5.3 
Bouton de la base de données 
d’images 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
6.6.0 
Base de données  
Figure 6.6.1  
Icône du mode de révision 
affichée dans le menu 
d’accueil  
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La base de données est essentiellement composée de trois sections ou sous-fenêtres. La 
section Patient List Table (Tableau de la liste des patients), en haut, la section Procedure 
List Table (Tableau de la liste des procédures), au centre, et la section Image Thumbnail 
List/Viewer (Liste/Visionneuse des vignettes d’images), en bas.  

 
Les tableaux des listes fonctionnent selon une hiérarchie descendante comme indiqué par 
la flèche : 

Liste des patients--->Liste des procédures--->Liste/Visionneuse des vignettes d’images. 

Lorsqu’un champ Patient est sélectionné, la fenêtre de procédure devient active. La fenêtre 
de procédure affiche une liste de toutes les procédures effectuées pour le patient 
sélectionné. De plus, toutes les images correspondant au patient sont affichées en bas à 
droite.  

 6.6.0 Suite 
 
 

Figure 6.6.2 
Image Database (Base de 
données d’images) 
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Lorsqu’une procédure est sélectionnée, la liste/visionneuse des vignettes est filtrée pour 
afficher uniquement les images correspondant à la procédure sélectionnée. Il est possible de 
sélectionner plusieurs procédures en maintenant la touche Majuscule enfoncée et en cliquant 
sur chaque procédure avec le bouton gauche de la souris. Toutes les images des procédures 
sélectionnées s’afficheront en conséquence. 

Le tri de la base de données peut être réglé en cliquant sur les champs supérieurs tels que l’ID 
du patient et le nom de famille pour trier selon l’un ou l’autre des critères. Lorsqu’un clic de 
souris est fait sur l’un des champs de la base de données, une petite flèche s’affiche dans le 
champ. En utilisant le bouton gauche de la souris et en sélectionnant à nouveau le champ, le 
dessin de la flèche passe d’ascendant à descendant ou inversement. Le champ sélectionné 
sera automatiquement trié en conséquence. 

Des barres de défilement sont situées dans la base de données pour faciliter la navigation. 

La liste/visionneuse des vignettes permet à un utilisateur de cliquer sur le symbole « + » pour 
ajouter automatiquement l’image à un volet de révision. Un utilisateur peut ajouter jusqu’à 
quatre images dans les volets de révision. Les volets de révision sont automatiquement ajustés 
pour englober les quatre images. 

Toutes les options du navigateur pour les images du patient actuel (voir Figure 6.5.2) sont 
également disponibles en haut de la page de la base de données. Des options supplémentaires 
sont également décrites à la Section 6.6.1. 

Remarque importante : les vignettes des images (.PNG) sont des fichiers distincts des fichiers 
de données d’images (DCM, DAT, DMM ou RAW). Elles portent le même nom de fichier que 
le fichier d’image, mais elles ont une extension de fichier (.PNG). Il est possible d’avoir un 
fichier image mais pas de « vignette ». Dans ce cas, Vision tentera de créer automatiquement 
une vignette pour l’image qui doit être chargée dans la base de données. Cependant, si cette 
opération échoue, l’image ne sera pas affichée. 

 
Save Image(s) (Enregistrer la/les images[s]) 

Le bouton Save Image(s) (Enregistrer la/les image[s]) est disponible lorsqu’une entrée du 
tableau des images ou de la liste des vignettes est sélectionnée ou par le biais des images 
patient actuelles, sinon il est désactivé. L’image sélectionnée peut être enregistrée dans les 
formats d’image 8 bits courants suivants : JPEG, BMP, TIFF et RAW. Elle peut également être 
enregistrée au format TIFF 16 bits. 

Le niveau de fenêtre de l’image enregistrée est le niveau de fenêtre par défaut. Si l’utilisateur 
souhaite que le niveau de la fenêtre soit modifié, il doit charger l’image dans Vue d’image et 
l’imprimer à partir de cet emplacement plutôt que de l’imprimer à partir de la boîte de dialogue 
de la base de données. 

Send Image(s) to PACS (Envoyer une/des image(s) au PACS) 
Cette fonction envoie une ou des images à un serveur PACS DICOM préconfiguré. Veuillez 
vous reporter à la Section 6.7.0 pour plus d’informations.  

Fonctions et outils du menu de la base de données d’images 

Il existe des fonctions pour naviguer, rechercher dans la base 
de données et pour modifier, supprimer et ajouter des 
enregistrements à la base de données. Ces fonctions sont 
détaillées dans les éléments du menu de la base de 
données. On y accède à partir du bouton supérieur intitulé 
Additional Options (Options supplémentaires) dans la base 
de données. 

 6.6.0 Suite 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6.6.1 
Options 
supplémentaires de 
la base de données 
 
Figure 6.6.3 
Menu Additional Options (Options 
supplémentaires) 
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Menu Open (Ouvrir) 
Le menu « Open » (Ouvrir) ne comporte qu’une seule option « Open Image from File » 
(Ouvrir l’image du fichier) qui ouvre une boîte de dialogue Windows permettant à l’utilisateur 
de naviguer et d’ouvrir des fichiers image situés sur des lecteurs locaux ou en réseau. 

Menu Print (Imprimer) 
Le menu « DB-PRINT » (IMPRIMER BD) offre des fonctionnalités d’impression par image, par 
procédure et par patient. Voir Figure 6.6.4. 

 

 

 

 

 

 

Print Image to Local Printer  
(Imprimer l’image sur l’imprimante locale) 

L’élément « Print Image to Local Printer » (Imprimer l’image sur l’imprimante locale) est 
disponible lorsque la saisie à partir du tableau des images ou de la liste des vignettes est 
sélectionnée, sinon il est désactivé. L’image sélectionnée sera imprimée avec l’imprimante 
locale par défaut du système Windows. 

Le niveau de fenêtre de l’image imprimée est le niveau de fenêtre par défaut. Il n’est pas 
recommandé aux utilisateurs d’imprimer à partir de ce menu, sauf s’ils sont satisfaits des 
impressions définies avec les nieaux de fenêtre par défaut calculés par le programme. 
L’utilisateur peut d’abord charger l’image dans la fenêtre Image View (Vue d’image) (Révision) 
et ensuite régler l’image aux niveaux de fenêtre souhaités. Lorsqu’il est satisfait du niveau de 
la fenêtre, l’utilisateur peut alors lancer l’impression à partir du menu de la fenêtre Image View 
(Vue d’image). Une boîte de dialogue Format Options (Options de formats) permet de choisir 
entre les formats d’impression. 

Print Image(s) to DCM Printer  
(Imprimer la/les image[s] sur l’imprimante DCM) 

Cette fonction envoie la ou les images à une imprimante DICOM préconfigurée. 

Menu View (Affichage) 
Le menu « View » (Affichage) offre à l’utilisateur un certain nombre d’options affectant 
l’affichage de la base de données. Voir Figure 6.6.5.  

 

 

 6.6.1 Suite 
 
 
 
 
 
 

Figure 6.6.4 
Menu d’impression de la base de 
données 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 6.6.5 
Menu d’affichage de la base de 
données 
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Show All DB Entries (Afficher toutes les entrées de la BD) 
Recharge le tableau Patient à partir du fichier de la base de données. Tout nouveau 
changement ou ajout à la base de données sera appliqué au tableau. Cette sélection efface 
également tout Search Filter (Filtre de recherche) actif qui aurait pu être appliqué aux tableaux. 
L’option Search Filter (Filtre de recherche) est expliquée en détail dans la partie Database 
Search (Rechercher dans la base de données) ci-dessous. 

Refresh DB Entries (Rafraîchir les entrées de la BD) 
Rafraîchit le tableau des patients, mais conserve tout Search Filter (Filtre de recherche) 
existant qui a été appliqué. 

Browse Data Directory (No DB)  
(Parcourir le répertoire des données [pas de BD]) 

Affiche toutes les vignettes d’images dans le répertoire des données établi par le fichier de 
configuration. Ces fichiers sont affichés dans la visionneuse de vignettes. Ils ne sont associés 
ni à la base de données ni aux listes des tableaux. Cet outil est utile pour examiner les images 
non enregistrées ou pour déboguer les problèmes de base de données lorsque des images 
sont présentes dans le répertoire de données actuel. 

Browse Any Directory (No DB)  
(Parcourir n’importe quel répertoire [pas de BD]) 

Permet à l’utilisateur de naviguer dans n’importe quel répertoire de fichiers. Ces fichiers sont 
affichés dans la visionneuse de vignettes. Ils ne sont associés ni à la base de données ni aux 
listes des tableaux. Cet outil est utile pour examiner un répertoire d’images qui n’a jamais été 
enregistré dans la base de données ou lorsque les enregistrements de la base de données 
sont corrompus. 

Menu Search (Rechercher) 
Les outils « Search » (Rechercher) de la base de données, voir Figure 6.6.6, permettent 
d’effectuer des recherches détaillées ou de filtrer la base de données. En sélectionnant le menu 
« DB-Search » (Rechercher dans la BD), l’utilisateur peut effectuer une recherche détaillée et 
spécifique. Lorsque le critère de recherche est saisi et activé dans la boîte de dialogue de 
recherche dans la BD, voir Figure 6.6.7, le filtre de recherche est appliqué à tous les tableaux 
de listes de la boîte de dialogue de la base de données d’image. Le critère de recherche activé 
est appelé Search Filter (Filtre de recherche) et ce filtre reste actif jusqu’à ce que l’utilisateur 
sélectionne « Stop Search » (Arrêter la recherche) dans le menu « DB-Search » (Rechercher 
dans la BD) ou « Show all DB Entries » (Montrer toutes les entrées de la BD) dans le menu 
« DB-View » (Afficher la BD). Le filtre de recherche actif est toujours affiché dans la légende 
de la boîte de dialogue de la base de données d’images. 

 

 
 
 
 
 

 

 6.6.1 Suite 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 6.6.6 
Menu de recherche dans la base 
de données 
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Start Search (Démarrer la recherche) 
« Start Search » (Démarrer la recherche) ouvre la boîte de dialogue de recherche dans la BD, 
ce qui permet de placer un FILTRE DE RECHERCHE actif sur la base de données. Lorsque la 
boîte de dialogue de recherche est ouverte, la page de la base de données est fermée et le 
logiciel retourne à la page d’acquisition d’images. La page de la base de données se rouvrira 
automatiquement après la fermeture de la boîte de dialogue de recherche. 

 
 
 
 
 

Les menus déroulants proposent des listes de catégories de recherche. Sélectionnez une 
catégorie de recherche et saisissez le paramètre de recherche souhaité pour lancer la 
recherche. Sélectionnez « Start » (Démarrer) pour lancer la recherche. Si une catégorie a plus 
d’une entrée distincte, alors toutes les entrées de cette catégorie seront affichées. 

Stop Search (Arrêter la recherche) 
« Stop Search » (Arrêter la recherche) désactive tout filtre de recherche actif, efface tous les 
tableaux de listes et recharge la liste de tous les patients dans le tableau de la liste des patients. 

Menu Tools (Outils) 
Le menu « DB-Tools » (Outils de BD) fournit des fonctions par image, par procédure, par 
patient, ainsi que des fonctions utiles pour réparer ou reformater la base de données. 
 
 
 
 
 
 
 
 
 
 
 
 

Edit Image Record (Modifier le dossier Image) 
La fonction « Edit Image Record » (Modifier le dossier Image) n’est pas disponible actuellement 
dans le logiciel Vision. 

Add Record to DB (Ajouter un dossier à la BD) 
Disponible lorsque la saisie à partir du Tableau des images ou de la Liste des vignettes est 
sélectionnée, sinon cette fonction est désactivée. Ceci est particulièrement utile lorsqu’un 
répertoire est parcouru alors que la base de données ne dispose d’aucune entrée pour les 
images dans ce répertoire. L’utilisateur peut sélectionner une seule image dans la liste des 
vignettes et ajouter des enregistrements de cette image dans la base de données. Si l’entrée 
de la base de données existe déjà pour l’image sélectionnée, il n’y a aucun danger, elle ne 
peut que mettre à jour la base de données en fonction de l’endroit où se trouve actuellement 
le fichier image, c’est-à-dire le nom du fichier/dossier.  

6.6.1 Suite 
 
 
 
 
 
 
Figure 6.6.7 
Lancement d’une recherche dans 
la base de données 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 6.6.8 
Menu Tools (Outils) de la base de 
données 
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Import Records in DIR to DB  
(Importer des enregistrements de RÉP vers BD) 

Cet outil permet de parcourir et de sélectionner un dossier, puis de remplir la base de données 
avec toutes les entrées correspondantes pour tous les fichiers image dans le répertoire 
sélectionné (y compris les sous-répertoires). Les formats d’images peuvent être DCM, DAT, 
DMM et RAW. Si des vignettes d’images manquent, cet outil générera également des vignettes 
BMP dans le même répertoire. 

Reformat All DB (Reformater toute la BD) 
L’outil « Reformat All DB » (Reformater toute la BD) permet de reformater les champs Date 
[AAAA/MM/JJ], Date/Heure [AAAA/MM/JJ HH:MM:SS] des tableaux et de mettre en 
majuscules les lettres des entrées de certains autres champs. C’est un outil utile lorsqu’un 
ancien fichier de base de données est importé et ouvert pour la première fois ou lorsque 
l’utilisateur modifie manuellement les entrées de la base de données à l’aide de MS Access. 

 
Remarques supplémentaires sur la base de données 

• La possibilité de quitter la base de données, en restant dans le mode Review (Révision) se 
trouve dans Additional Options (Options supplémentaires).  

• Le bouton en haut à gauche se règle automatiquement pour ramener l’utilisateur à 
l’acquisition, ou au menu principal, ou il devient le bouton Close Database (Fermer la 
base de données) selon le flux de travail utilisé pour aller à l’écran de la base de données et 
ce qui est le plus approprié. 

Modifier ou supprimer des informations  
sur le patient de la base de données 

L’utilisateur peut modifier ou supprimer des informations sur le patient dans la base de 
données. Cliquez avec le bouton droit de la souris sur l’entrée du patient dans la partie 
supérieure de la base de données pour ouvrir une boîte de dialogue. Voir Figure 6.6.9.  

 

Cliquer sur « Edit Patient Information » (Modifier 
les informations sur le patient) ouvre une boîte de 
dialogue « Patient Information » (Informations sur 
le patient). Voir Figure 6.6.10. Cliquez sur Cancel 
(Annuler) pour revenir à la base de données sans 
effectuer ou enregistrer de modifications. Cliquer 
sur Save Changes (Enregistrer les modifications) ouvre une boîte de dialogue 
« Confirmation ». Cliquez sur Yes (Oui) pour confirmer et continuer. Les modifications sont 
maintenant enregistrées et l’utilisateur sera renvoyé à la base de données. No (Non) annulera 
les modifications et retournera à la base de données. Cancel (Annuler) renvoie l’utilisateur à 
la boîte de dialogue « Patient Information » (Informations sur le patient).  

Remarque : si le système a un mot de passe de démarrage activé (voir la rubrique Utilitaire de 
connexion à la Section 6.4.4 et la Figure 6.4.21), le même mot de passe sera demandé lors de 
la tentative « Delete Patient Information » (Supprimer des informations sur le patient) de la 
base de données. 

 6.6.1 Suite 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 6.6.9 
Boîte de dialogue Edit/Delete 
(Modifier/Supprimer) (à gauche) 
 
Figure 6.6.10 
Informations sur le patient (à droite) 
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La norme DICOM 
Qu’est-ce que la norme DICOM ? 

La norme DICOM (Digital Imaging and Communications in Medicine) est une série de 
protocoles utilisés par les équipements et les logiciels médicaux pour permettre aux données 
d’être compatibles et interchangeables avec d’autres équipements ou logiciels médicaux. 

Lorsqu’un fichier est enregistré dans un format DICOM, un fichier est créé. Celui-ci comprend 
les données pertinentes du patient, les données de l’équipement d’imagerie, du matériel ainsi 
que les données d’image, le tout dans un seul fichier. De plus, le fichier enregistré contient des 
caractéristiques spécifiques qui permettent à l’ordinateur et au logiciel de l’identifier comme un 
fichier conforme à la norme DICOM. Une fois qu’une application logicielle reconnaît le fichier 
comme un fichier conforme à la norme DICOM, elle peut lancer un lecteur DICOM et extraire 
les données correctement, quelle que soit l’origine du fichier. 

Un fichier créé à l’aide du protocole DICOM a la structure suivante : 

Lorsque le préambule est constitué de 128 octets, tous sont généralement définis sur 00H, sauf 
s’il n’est pas utilisé par un profil d’application ou une implémentation spécifique ; le préfixe est 
constitué de 4 octets, constituant la chaîne de caractères « DICM » codée en majuscules du 
répertoire de caractères G0 de la norme ISO 8859 ; les éléments de données sont 
arbitrairement grands (ou petits) et contiennent les données. 

Modalité 
Les paramètres du fichier DICOM pour la modalité sont accessibles à partir de la barre de menu 
supérieure en sélectionnant « DICOM Utilities » (Utilitaires DICOM), puis « DICOM Modality 
Setup » (Configuration de modalité DICOM). 
 
 
 
 
 
 
Le type de stockage DICOM, soit Présentation soit Traitement, peut être sélectionné. La même 
boîte de dialogue permet de sélectionner la modalité d’image DICOM, soit radiographie 
numérique soit mammographie numérique. Les paramètres « Transfer Syntax » (Syntaxe de 
transfert) et « Value Representation » (Représentation de valeur) ne peuvent pas être définis 
par l’utilisateur. Ils sont toujours paramétrés sur META HEADER PRESENT, LITTLE_ENDIAN 
et VR_IMPLICIT. 

 6.7.0 
Fonctionnalité 
DICOM 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 6.7.1 
Structure du protocole DICOM 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 6.7.2 
Menu DICOM Utilities (Utilitaires 
DICOM) 

 



 
 
 
 
 

MANUEL DE L’UTILISATEUR DU FAXITRON CORE | HOLOGIC | RÉVISION 045  

SECTION 
Fonctionnement 
du logiciel Vision 6 

6 - 35 

Faxitron® Core 
Système de radiographie d’échantillons 

 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
REMARQUE : une fois les modalités DICOM sélectionnées, elles restent en vigueur, même 

après la fermeture du logiciel Vision. Les paramètres de la modalité sont 
stockés et resteront mémorisés dans la configuration jusqu’à ce qu’ils soient 
modifiés à nouveau, en utilisant les paramètres du fichier DICOM. Ces 
paramètres (de type de stockage et de modalité, de syntaxe de transfert, et de 
représentation des valeurs) seront effectifs pour toutes les fonctionnalités 
DICOM « Local Save » (Enregistrer en local) ou « Local Print » (Imprimer en 
local). 

Default DICOM Servers (Serveurs DICOM par défaut) 
Cette section contient des paramètres pour les serveurs DICOM par défaut et pour automatiser 
certains des processus lors du stockage, de l’impression ou de la recherche de serveurs PACS 
et MWL. 

Les cases à cocher « Enable Single-Click Auto Store » (Activer le stockage automatique en un 
seul clic), « Print » (Imprimer) ou « MWL Connection » (Connexion MWL) permettent à 
l’utilisateur de stocker ou d’imprimer des images ou de se connecter automatiquement au 
serveur MWL. Si vous utilisez un seul serveur PACS pour ces actions ou si la majorité de votre 
travail concerne un seul serveur PACS, cochez la case souhaitée pour automatiser ces actions. 

La case « Enable Auto Search When Connecting to MWL Server » (Activer la recherche 
automatique lors de la connexion au serveur MWL) indique à l’application d’effectuer 
automatiquement une recherche avec les paramètres de recherche par défaut lors de la 
recherche des données des patients. 

 6.7.0 Suite 
 

Figure 6.7.3 
Paramètres de Modalité DICOM 
Paramètres par défaut 
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La case « Auto close dialog after N seconds of successful transfer/printing » (Fermeture 
automatique de la boîte de dialogue après N secondes de transfert/impression réussi[e]) ferme 
automatiquement la boîte de dialogue du réseau DICOM après un nombre de secondes 
spécifié. La boîte de dialogue ne se ferme pas automatiquement en cas d’erreur de transfert ou 
d’impression. 

Cliquer sur le bouton DICOM Servers (Serveurs DICOM) ouvre la boîte de dialogue réseau 
DICOM où un utilisateur peut ajouter, modifier ou supprimer des serveurs DICOM. Voir 
Figure 6.7.5. 

DICOM Save Local (Enregistrer DICOM en local) 
Pour enregistrer l’image actuelle sur un lecteur local/répertoire, cliquez avec le bouton droit de 
la souris n’importe où dans l’image. Cela affichera la boîte de dialogue présentée dans la 
Figure 6.7.4 ci-dessous. Cliquez sur « Save/Store current image » (Enregistrer/Stocker l’image 
actuelle) puis sur « As Local DICOM image » (En tant qu’image DICOM locale). Cela fera 
apparaître la boîte de dialogue standard d’enregistrement de fichiers de Windows. Naviguez ou 
cliquez sur le répertoire/dossier souhaité, entrez le nom du fichier et cliquez sur Save 
(Enregistrer). 

 

 

 

 

 

PACS Store and PACS Print  
(Enregistrement PACS et impression PACS) 

Le logiciel Vision permet l’enregistrement PACS (DICOM) et l’impression PACS (DICOM). Ces 
options sont disponibles dans l’ensemble du logiciel. Par exemple, si le bouton PACS Store 
(Enregistrement PACS) est sélectionné, la fenêtre de dialogue suivante avec le réseau DICOM 
peut être affichée. Cette boîte de dialogue permet à l’utilisateur d’effectuer un enregistrement 
DICOM, d’effectuer une impression DICOM, ou d’ajouter, de modifier ou de supprimer des 
connexions réseau ou des périphériques DICOM. 

 

 

 

 

 

 

 

 6.7.0 Suite 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 6.7.4 
Boîte de dialogue Save Current 
Image (Enregistrer l’image 
actuelle) 
 
 
 
 
 
 
 
 
 
 
 
Figure 6.7.5 
Boîte de dialogue DICOM 
Networking (Réseau DICOM) 
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PACS DICOM Store (Enregistrement PACS DICOM) 
Le logiciel Vision prend en charge le service C-STORE DICOM 3.0. Ceci permet d’envoyer une 
image ou une série d’images (selon une procédure spécifiée) à un système de stockage distant 
conforme à l’entité d’application (AE) DICOM, comme le PACS. Là encore, la fonction DICOM 
Store (Enregistrement DICOM) est accessible dans l’ensemble du logiciel Vision. Les 
modifications de la présentation et du traitement peuvent être effectuées par le biais de la 
configuration de la modalité DICOM, dans le menu Tools (Outils).  

Remarque : pour l’enregistrement DICOM, la case « SET FILM Attributes » (PARAMÉTRER 
les attributs du film) est grisée. 

L’utilisateur peut ajouter une nouvelle configuration pour une AE DICOM distante à laquelle 
envoyer l’image ou choisir parmi une configuration déjà existante, affichée dans Connexions 
réseau DICOM, dans la boîte de dialogue DICOM Networking (Réseau DICOM). En double-
cliquant (ou avec un seul clic et en appuyant sur le bouton Connect [Connecter]) sur l’icône de 
l’AE DICOM distante, le logiciel Vision se connecte et établit une association DICOM avec l’AE 
distante sélectionnée. Une fois l’association réussie, l’image peut être envoyée pour être 
enregistrée en appuyant sur le bouton Store (Enregistrer). Après avoir sélectionné le bouton 
Store (Enregistrer), le logiciel Vision envoie l’image sélectionnée à l’AE DICOM distante définie. 
Si l’opération de mémorisation est réussie, l’AE DICOM distante envoie une confirmation de 
réception et d’enregistrement de la ou des images. Si l’opération échoue, l’AE DICOM distante 
enverra un code d’erreur indiquant la raison de l’échec. 

Une seule image peut également être envoyée pour être enregistrée en cliquant avec le bouton 
droit de la souris sur la vignette de l’image (dans le navigateur de la base de données) et en 
suivant la même procédure que celle décrite précédemment. Il est possible d’envoyer toute une 
série (Procédure) d’images pour enregistrement. Pour ce faire, cliquez avec le bouton droit de 
la souris sur le nom de la série (Procédure), affiché dans l’écran du navigateur de base de 
données, puis suivez le même protocole que celui décrit ci-dessus. 

Add Session (Ajouter une session) 
Le bouton Add Session (Ajouter une session) ouvre la boîte de dialogue de session par laquelle 
l’utilisateur peut configurer une nouvelle connexion à une entité d’application DICOM distante.  

Pour créer une nouvelle configuration de connexion à une AE DICOM distante, l’utilisateur doit 
disposer des informations suivantes : le titre de l’entité d’application (AE Title), le choix de la 
« fonction à exécuter » DICOM/PACS, l’adresse IP et le numéro de port du serveur (c’est-à-
dire de l’imprimante DICOM ou du système PACS).  

Le titre AE et le numéro de port du système de l’utilisateur (c’est-à-dire le client) sont également 
nécessaires. Remplissez les champs de données correspondants et sélectionnez OK pour 
créer une nouvelle configuration. 

Choix du comportement de la fonction de  
session DICOM/PACS par défaut 

Il y a actuellement quatre (4) types de fonctions 
qu’une session DICOM peut utiliser par défaut. 
Celles-ci se trouvent dans la liste déroulante 
Fonction (cases combinées) comme indiqué 
dans la Figure 6.7.6 ci-dessous. La liste est la 
suivante :  

1. Connexion GENERAL (GÉNÉRALE) 
DICOM/PACS. 

2. Connexion STORE (ENREGISTREMENT) 
DICOM. 

3. Connexion PRINTER (IMPRIMANTE) 
DICOM. 

4. Connexion WORKLIST (LISTE DE 
TRAVAIL) de la modalité DICOM. 

 6.7.0 Suite 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 6.7.6 
Boîte de dialogue Session 
Properties (Propriétés de la 
session) 
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Le but de la « Fonction » DICOM est de permettre la création (l’ajout) d’une Session/ 
Connexion qui à son tour permet d’utiliser un « dispositif » DICOM/PACS uniquement tel que 
l’utilisateur l’a configuré pour une catégorie de fonctions particulière. Une fois configuré, 
lorsque vous visualisez ou utilisez la « DICOM Networking Dialog » (Boîte de dialogue 
réseau DICOM) (voir Figure 6.7.5), seule l’icône correspondant à la fonction choisie sera 
« active et illuminée ». C’est-à-dire qu’elle aura une couleur bleue par opposition à une 
couleur « grisée ». Par exemple, dans la Figure 6.7.5, il y a trois (3) icônes représentant, 
dans l’ordre : un enregistrement PACS (DICOM Store 1), une impression PACS (DICOM 
Print 1) et une liste de travail des modalités (DICOM-MWL). Comme l’icône DICOM Store 
(Enregistrement DICOM) a été choisie précédemment, elle est la seule active (écran bleu). 
Les autres modes fonctionnent de la même manière. 
 

Modify Session (Modifier la session) 
Le bouton Modify Session (Modifier la session) ouvre la boîte de dialogue pour l’AE DICOM 
sélectionnée. Dans cette fenêtre, l’utilisateur peut modifier les informations du serveur et du 
client décrites dans la partie Add Session (Ajouter une session). 

 

Remove Session (Supprimer la session) 
Le bouton Remove Session (Supprimer la session) supprime la configuration de l’AE 
DICOM sélectionnée du logiciel Vision. Une fois supprimée, une configuration AE DICOM ne 
peut pas être restaurée, sauf si l’utilisateur saisit à nouveau manuellement les données 
requises par le biais du bouton Add Session (Ajouter une session). Une confirmation d’action 
sera demandée, voir ci-dessous. 
 
 
 
 
 

 6.7.0 Suite 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 6.7.7 
Vérification de la suppression 
d’une connexion réseau 
DICOM existante  
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Association 
 
Le bouton Association List (Liste des associations) ouvre la boîte de dialogue Association, 
représentée ci-dessous, grâce à laquelle l’utilisateur peut modifier les paramètres et les 
protocoles utilisés par le logiciel Vision lors de la négociation d’une connexion avec une AE 
DICOM distante. Ces options doivent être modifiées uniquement par un utilisateur avancé, 
familiarisé avec les protocoles d’association DICOM. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Attributs du film 
 
En sélectionnant « Set DICOM Print Film Attributes » (Paramétrer les attributs d’impression du 
film) dans le menu « Command » (Commande) (Figure 6.7.9), la boîte de dialogue de 
configuration de l’imprimante DICOM s’affiche. Voir Figure 6.7.10. Dans cette boîte de dialogue, 
l’utilisateur peut sélectionner diverses options régissant le film et le format d’impression. La 
sélection de l’option Default (Par défaut) rétablit toutes les options par défaut. Les 
configurations des paramètres sont accessibles via des menus déroulants. Pour accepter la 
configuration modifiée, sélectionnez OK. Pour rejeter les options et quitter la fenêtre sans 
apporter aucun changement, sélectionnez Cancel (Annuler).  
 
 
 
 
 
 

 6.7.0 Suite 
 
 
 
 

Figure 6.7.8 
Fenêtre Association DICOM 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 6.7.9 
Paramétrer les attributs 
D’IMPRESSION DU FILM DICOM 
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Impression PACS 
 
L’option Impression PACS envoie l’image sélectionnée à l’imprimante PACS DICOM 
sélectionnée. L’image est imprimée selon les options de format de film et d’impression 
spécifiées dans la boîte de dialogue Set Film Attributes (Configurer les attributs du film) décrite 
précédemment. Si l’utilisateur lance l’impression PACS à partir de Image View (Vue image), 
alors le niveau de la fenêtre sera choisi dans cette vue image. Si l’impression PACS est lancée 
à partir de la boîte de dialogue Base de données, alors le niveau de la fenêtre sera le niveau 
de fenêtre par défaut calculé par le logiciel Vision. 
 
 

Close (Fermer) 
 
Le bouton Close (Fermer) ferme la boîte de dialogue DICOM Networking (Réseau DICOM) et 
fait revenir l’utilisateur dans la zone à partir de laquelle la commande DICOM a été exécutée. 
Cette commande ferme également la connexion ou l’association entre le logiciel Vision et le 
périphérique DICOM distant si une connexion a été établie. 
 

 6.7.0 Suite 
 
Figure 6.7.10 
Boîte de dialogue de configuration 
de l’imprimante DICOM 
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Vue d’ensemble 
 
L’option User Annotations (Annotations de l’utilisateur) dans le logiciel Vision de permet 
d’appliquer une « superposition » graphique transparente sur une image, communément 
appelée « annotations ». Ces annotations peuvent être un texte, des lignes, des lignes de 
« forme libre » (courbes de Bézier), des flèches, des ellipses et des boîtes. Cela permet 
d’ajouter des informations supplémentaires et des « marqueurs » sur l’image si besoin. Notez 
que toutes les annotations peuvent être facilement activées ou désactivées, en d’autres termes, 
elles peuvent être affichées ou masquées à volonté. 
 

Utilisation 
 
Pour commencer l’annotation, sélectionnez l’outil Annotations dans le menu de gauche. 
Voir es Figures 6.4.1 et 6.8.1. En ouvrant cette boîte de dialogue, le logiciel met immédiatement 
l’utilisateur en mode conception. Il affichera aussi une « palette d’outils ». Voir Figure 6.8.2 
ci-dessous.  

 

 

Le fait de sélectionner Save (Enregistrer) ou Cancel (Annuler) dans cette boîte de dialogue 
annulera les annotations précédentes ou enregistrera les annotations actuelles dans la fenêtre. 
Il vous ramènera également au mode d’imagerie normal. 

La palette d’outils est composée des quinze (15) options d’outils suivants. Cependant, les outils 
peuvent être tronqués aux 8 outils les plus courants, en fonction des besoins de l’utilisateur ; ils 
sont affichés dans la ligne supérieure de la boîte de dialogue.  

Notez que le comportement de la plupart de ces options d’outils implique l’utilisation de la souris 
pour guider la position et la forme dynamiques à l’écran. Les « clics » de la souris sont utilisés 
pour définir les positions et les formes finales.  

Le terme « balayer » signifie que l’on maintient le bouton gauche de la souris enfoncé et que 
l’on déplace l’objet sur l’écran. Le fait de relâcher le bouton gauche de la souris ou de cliquer 
sur le bouton droit de la souris mettra l’annotation en position « permanente » ou finale. 

 

 
 
En commençant dans le coin supérieur gauche de la Figure ci-dessus, une description de 
chaque option d’outil est donnée ci-après. 
 
 

  6.8.0 
Annotations de 
l’utilisateur 
 
 
 
 
 
 
 
 
 
 
Figure 6.8.1 
Palette d’outils de 
conception des annotations de 
l’utilisateur 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 6.8.2 
Palette d’outils de 
conception des annotations de 
l’utilisateur 
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1. Outil de sélection : utilisez cet outil pour sélectionner (mettre en surbrillance) un objet 
d’annotation courant. Cliquez et maintenez le bouton gauche de la souris enfoncé, ce qui 
définit une position de départ, puis déplacez la souris. Les annotations qui se trouvent à 
l’intérieur de la boîte affichée seront sélectionnées pour une utilisation ultérieure. Relâchez 
le bouton gauche de la souris pour terminer l’opération. 

2. Outil ligne : cette option permet de tracer une ligne droite. Le comportement de la souris 
est le même que ci-dessus. 

3. Outil boîte : dessine une boîte. Le comportement de la souris est le même que ci-dessus. 

4. Outil ellipse (et cercle) : dessine une ellipse ou un cercle. Le comportement de la souris 
est le même que ci-dessus.  

5. Outil flèche : dessine une ligne avec une flèche à son extrémité. Le comportement de la 
souris est le même que celui de l’outil ligne. 

6. Outil ligne ouverte de polygone : dessine des lignes non droites « à segments ouverts ». 
Cliquez sur le bouton gauche de la souris, maintenez le bouton enfoncé, dessinez. 
Relâchez le bouton gauche, ceci définit un segment de ligne. Répétez autant de fois que 
désiré. Cliquez sur le bouton droit de la souris et le fonctionnement de l’outil se termine. 

7. Outil texte : crée une « zone de texte » où vous pouvez saisir des données sous forme de 
texte. 

8. Outil règle : crée un segment de ligne gradué. Très similaire à la fonction Règle des outils 
d’image. 

9. Outil ligne fermée de polygone : dessine des lignes non droites « à segments fermés ». 
Cliquez sur le bouton gauche de la souris, maintenez le bouton enfoncé, dessinez. 
Relâchez le bouton gauche, ceci définit un segment de ligne. Répétez autant de fois que 
désiré. Cliquez sur le bouton droit de la souris et le fonctionnement de l’outil se termine. 

10. Outil ligne courbe ouverte : dessine des lignes courbes « ouvertes et segmentées ». 
(Courbes de Bézier.) Cliquez sur le bouton gauche de la souris, maintenez le bouton 
enfoncé, dessinez. Relâchez le bouton de gauche, cela définit un segment de ligne courbe. 
Répétez autant de fois que désiré. Cliquez sur le bouton droit de la souris et le 
fonctionnement de l’outil se termine. 

11. Outil ligne courbe fermée : dessine des lignes courbes « fermées et segmentées ». 
(Courbes de Bézier.) Cliquez sur le bouton gauche de la souris, maintenez le bouton 
enfoncé, dessinez. Relâchez le bouton de gauche, cela définit un segment de ligne courbe. 
Répétez autant de fois que désiré. Cliquez sur le bouton droit de la souris et le 
fonctionnement de l’outil se termine.  

12. Outil infobulle (texte) : crée une zone de texte avec un segment de ligne dépassant d’un 
coin de la zone de texte. Ceci peut être utilisé pour « relier » le texte à un élément sur votre 
image. 

13. Règle segmentée : dessine des lignes graduées non droites « ouvertes et segmentées ». 
Cliquez sur le bouton gauche de la souris, maintenez le bouton enfoncé, dessinez. 
Relâchez le bouton gauche, ceci définit un segment de ligne gradué. Répétez autant de 
fois que désiré. Cliquez sur le bouton droit de la souris et le fonctionnement de l’outil se 
termine. La longueur de tous les segments de ligne gradués est indiquée à l’extrémité de 
la règle. Utile pour une estimation approximative de la circonférence d’un objet ou d’un 
patient. 

14. Outil rapporteur : dessine un angle sur l’écran et indique la valeur de l’angle en degrés. 
Comme un rapporteur. 

15. Outil règle orthogonale : crée deux (2) lignes graduées qui sont à angle droit l’une par 
rapport à l’autre. 

 6.8.0 Suite 
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Mode de conception et menu contextuel (clic droit de la souris) 
 
En mode User Annotation Design Mode (Conception des annotations de l’utilisateur), mais pas 
dans un mode de fonctionnement spécifique, il est possible de faire un clic droit de la souris 
pour afficher un menu contextuel. Voir ci-dessous. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
De nombreux réglages spécifiques peuvent être effectués à partir de ces menus contextuels. 
 
Remarque : si un élément semble trop petit pour être lu ou vu correctement, vous pouvez 
éventuellement le modifier à partir des menus contextuels présentés ci-dessus. Vous pouvez 
également choisir de zoomer dans l’image à l’aide de l’outil Dynamic Zoom (Zoom dynamique). 
Ceci agrandit l’image et vous devriez pouvoir voir clairement toutes les annotations. 
 
 
 

Afficher/masquer les annotations 
 
Le bouton Toggle Annotations (Basculer les annotations) illustré à la Figure 6.8.4, 
permet aux utilisateurs d’activer et de désactiver rapidement les annotations. Par 
défaut, les annotations seront activées. Le bouton est situé dans le menu de droite, 
près du coin supérieur droit. 
 
 

 6.8.0 Suite 
 
 
 
 
Figure 6.8.3 
Menu contextuel de la souris (clic 
droit) (uniquement en mode de 
conception des annotations de 
l’utilisateur) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 6.8.4 
Option Show/Hide 
(Afficher/Masquer) pour 
les annotations de l’utilisateur 
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Le menu « Help » (Aide), voir Figure 6.9.1, est situé sur la barre de menu supérieure et permet 
d’accéder rapidement au « User’s Manual » (Manuel de l’utilisateur) Faxitron Core et à « About 
Vision » (À propos de Vision). Reportez-vous à la Figure 6.10.1. 
 
 
 
 
 
 
 
 
 
 
 
 

 6.9.0 
Aide 
 
Figure 6.9.1 
Menu Aide 
 

Le sous-menu « About Vision » (À propos de Vision) ouvre une boîte de dialogue qui affiche la 
version du logiciel Vision, le copyright, la date et les informations sur le système. 
 

 

 6.10.0 
À propos du 
logiciel Vision 
 
Figure 6.10.1 
Boîte de dialogue 
d’informations About Vision 
(À propos du logiciel Vision) 
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Historique des révisions 

Révision Date Description de la modification Auteur/ 
Initiateur 

Approuvé 
par 

2.0.2 Avril 2010 Manuel de l’utilisateur du Faxitron Core 
d’origine. Inconnu Inconnu 

3.0 7-23-2012 

• Modification du numéro de document de 
1043C en 05-5280-04. 

• Modification du titre de « Manuel de l’utilisateur 
avancé pour le Faxitron Core Bioptics » en 
« Manuel de l’utilisateur du Faxitron Core ». 

• Modification du nom sur la page de garde pour 
Faxitron. 

• Modification de toutes les références de la 
société de Bioptics en Faxitron Bioptics. 

• Suppression des Sections 3 et 6. Ces 
informations sont traitées dans d’autres 
sections. 

• Suppression des Sections 7 et 8. Ces 
informations sont couvertes dans le manuel 
technique de BioVision. 

• Insertion de la nouvelle Section 2 : sécurité 
concernant le rayonnement et rayons X. 

• Insertion de la nouvelle Section 3 : à propos de 
votre BioVision. 

• Révision substantielle effectuée dans le reste 
du document. 

Alan Mihalko Akif Baysal 

3.1 2-4-2015 

Mise à jour des images dans le manuel pour 
refléter le schéma de couleurs actuel de 
Faxitron Core et le logo de la société. 
Ajout du tableau de l’historique des révisions. 

Paul Hess Mikhail Viznyuk 

3.2 7-28-2015 

P.78 Correction de la coquille au niveau de 
la Figure. 

P.81/82 Suppression du texte répété. 
P.86 Correction de l’endroit de la référence. 
P.88 Correction de la référence de la Figure. 
P.98 Suppression du texte répété. 
P.99 Correction de la description de la 

recherche. 
P.103 Suppression du texte répété. 
P.109 Correction des références. 

Paul Hess Mikhail Viznyuk 
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Révision Date Description de la modification Auteur/ 
Initiateur 

Approuvé 
par 

3.3 7-07-2016 

P.61 Correction de l’étiquette pour la 
Figure 5.2.18. 

P.65 Correction des erreurs dans le protocole 
de séquence. 

P.90 Correction de la référence de la Figure 
de  6.9 à 6.5.1 dans la Section 6.5.0. 

P.98 Suppression de la « période » 
supplémentaire de la Figure 6.6.4. 

P.101 Suppression de la « période » 
supplémentaire de la Figure 6.6.8. 

Alan Mihalko Mikhail Viznyuk 

4.0 10-24-2018 

Mise à jour majeure pour inclure le nouveau 
logiciel Vision (métro). Ajout du représentant de 
l’UE. Mise à jour des images selon les besoins. 
Ajout de numéros de section et suppression de 
l’index. 

Cary McLaughlin Ciaran Purdy 

041 7-16-2019 

• La Section 0 a été mise à jour pour inclure 
les indications d’utilisation. 

• Mise à jour du représentant autorisé au 
sein de l’UE dans la Section 1. 

• Mise à jour des sources du tableau des 
doses de rayonnement dans la Section 2. 

• Section 3 — ajout d’informations sur la 
version DICOM et la production de chaleur. 

• Section 4 — ajout d’informations sur 
l’interopérabilité et la cybersécurité. 

• Section 5 — Section rationalisée et 
réorganisée.  

o Suppression d’informations qui n’étaient 
pas directement liées au fonctionnement de 
base du système.  

• Section 6 — Réorganisation de 
nombreuses sous-sections pour une 
progression plus logique. 

o Révision de la séquence de démarrage. 
o Révision de la section sur l’étalonnage de 

la caméra. 
o Modification du flux des données du 

patient. 
o Révision de diverses sous-sections pour 

plus de clarté. 
• Mise à jour des captures d’écran dans tout 

le document. 

Alan Mihalko 

S. Howerton 
J. Mudd 
D. Canny 
D. Saraiya 
R. Nash 
T. Longo 
M. Fremont 

042 12-03-2019 Mise à jour de l’image de marque Dhaval Saraiya Voir CCB 
043 12-10-2020 Mise à jour de l’image de marque Steven Holmes Voir CCB 
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Approuvé 
par 

044 Août 2021 

Ajout du symbole « Consulter le mode 
d’emploi » et de l’adresse/lien Web « notices » 
Ajout du sponsor AU et des coordonnées au 
Brésil 
Ajout d’un tableau pour les « Symboles 
d’avertissement et de mise en garde sur 
l’étiquette » 
Mise à jour des coordonnées du service 

Alan Mihalko Voir CCB 

045 Août 2021 Suppression des coordonnées au Brésil Alan Mihalko Voir CCB 
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